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アシュアランスの制限事項と制約事項
アシュアランスでは、ネットワークアドレス変換（NAT）を介して接続されたデバイスをサ
ポートしません。

基本的な設定のワークフロー
アシュアランスアプリケーションの使用を開始する前に、アシュアランスを使用するために

Cisco DNA Centerを設定する必要があります。

ここでは、アシュアランスを設定するために実行する必要がある基本タスクについて説明しま

す。この章は、Cisco DNA Centerユーザガイドと併用してください。

基本的なワークフローを理解するために、次の図と次の手順を参照してください。

アシュアランスを使用するための Cisco DNA Centerの設定
1

https://www.cisco.com/c/en/us/support/cloud-systems-management/dna-center/products-user-guide-list.html


図 1 :アシュアランスを使用するための Cisco DNA Centerの設定の基本的なワークフロー
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始める前に

アシュアランスの制限事項と制約事項（1ページ）を参照してください。

ステップ 1 Cisco DNA Centerをインストールします。

Cisco DNA Center設置ガイドを参照してください。

ステップ 2 任意の順序で次の操作を行います。

•デバイス（ルータ、スイッチ、ワイヤレスコントローラ、アクセスポイント）を検出します。

IPアドレス範囲を使用したネットワークの検出（15ページ）、CDPを使用したネットワークの検
出（7ページ）、およびLLDPを使用したネットワークの検出（23ページ）を参照してください。

Ciscoワイヤレスコントローラは、サービスポート IPアドレスではなく、管理 IPアド
レスを使用して検出する必要があります。それ以外の場合は、関連するワイヤレスコン

トローラ 360および AP 360のウィンドウでは、データが表示されません。

（注）

•新しいネットワーク階層を設計するか、既存のものを使用します。

新しいネットワーク階層の設計（33ページ）または既存のCiscoネットワーク階層の使用（33ペー
ジ）を参照してください。

サイトがすでに作成されている場合は、このステップをスキップし、Discoveryを実行で
きます。

（注）

ステップ 3 デバイスインベントリにデバイスが表示されることを確認します。

インベントリに関する情報の表示（54ページ）を参照してください。

デバイスをサイトに追加する前に、すべてのデバイスが管理状態になるのを待つ必要があり

ます。

（注）

ステップ 4 サイトへのデバイスの追加

デバイスをサイトに追加する（61ページ）を参照してください。

ステップ 5 APがある場合は、フロアマップに追加することをお勧めします。

ステップ 6 ネットワークでのユーザー認証に Cisco Identity Services Engine（ISE）を使用している場合、アシュアラ
ンスを設定して Cisco ISEを統合できます。統合することで、アシュアランスのユーザー名やオペレー
ティングシステムなど、有線クライアントの詳細な情報を参照できます。

Cisco DNA Center向けの Cisco ISEの設定について（62ページ）を参照してください。

ステップ 7 テレメトリを使用して、Syslog、SNMPトラップ、および NetFlowコレクタサーバーを設定します。

テレメトリを使用した Syslog、SNMPトラップ、NetFlowコレクタサーバー、および有線クライアント
データ収集の設定（66ページ）を参照してください。

ステップ 8 （推奨）AI駆動型の問題を確認し、ネットワークインサイトを取得するには、CiscoAINetworkAnalytics
データ収集を設定します。
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Cisco AI Network Analyticsデータ収集の設定（67ページ）を参照してください。

ステップ 9 （推奨）最新の機械推論ワークフローにアクセスするには、機械推論ナレッジベースを更新します。

機械推論ナレッジベースの更新（70ページ）を参照してください。

ステップ 10 アシュアランスアプリケーションの使用を開始します。

デバイスの検出
Cisco DNA Centerディスカバリ機能を使用してネットワーク内のデバイスをスキャンします。

検出の概要

ディスカバリ機能は、ネットワーク内のデバイスをスキャンし、検出されたデバイスの一覧を

インベントリに送信します。

また、ディスカバリ機能は、デバイスの可制御性機能と連携して、デバイスに必要なネット

ワーク設定を構成することもできます（これらの設定がデバイスにまだ存在しない場合）。

デバイスは次の 3つの方法で検出できます。

• Cisco Discovery Protocol（CDP）を使用し、シード IPアドレスを指定します。

• IPアドレスの範囲を指定します（最大 4096デバイスの範囲がサポートされます）。

• Link Layer Discovery Protocol（LLDP）を使用し、シード IPアドレスを指定します。

ディスカバリ基準を設定する際は、ネットワーク検出時間を短縮するために役立つ設定がある

ことに注意してください。

• [CDP Level]と [LLDP Level]：CDPまたは LLDPをディスカバリ方式として使用する場合
は、CDPレベルまたはLLDPレベルを設定して、スキャンするシードデバイスからのホッ
プ数を指定できます。デフォルトのレベル 16では、大規模なネットワークの場合に時間
がかかる可能性があります。そのため、検出する必要があるデバイスが少ない場合は、こ

のレベルをより低い値に設定できます。

• [Subnet Filters]： IPアドレスの範囲を使用する場合は、特定の IPサブネット内のデバイス
をディスカバリで無視するように指定できます。

• [Preferred Management IP]：CDP、LLDP、または IPアドレスの範囲のいずれを使用する場
合でも、CiscoDNACenterがデバイスの任意の IPアドレスを追加するか、デバイスのルー
プバックアドレスのみを追加するかを指定できます。
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Cisco SD-Accessファブリックおよび Cisco DNAアシュアランス
については、デバイスのループバックアドレスを指定することを

お勧めします。

（注）

どの方式を使用する場合でも、Cisco DNA Centerからデバイスにアクセスできる必要があり、
デバイスを検出するための特定のクレデンシャルとプロトコルをCiscoDNACenterで設定する
必要があります。これらのログイン情報は、[Design] > [Network Settings] > [Device Credentials]
ウィンドウで（または [Discovery]ウィンドウでジョブごとに）設定して保存することができ
ます。

デバイスが Hot Standby Router Protocol（HSRP）や Virtual Router Redundancy Protocol（VRRP）
などのファーストホップ解決プロトコルを使用する場合、そのデバイスは、そのフローティン

グIPアドレスによって検出され、インベントリに追加される可能性があります。その後、HSRP
または VRRPに障害が発生すると、その IPアドレスが別のデバイスに割り当てなおされる場
合があります。この場合、Cisco DNA Centerが分析のために取得するデータによって問題が発
生する可能性があります。

（注）

ディスカバリの前提条件

ディスカバリを実行する前に、次の最小要件を満たしてください。

• Cisco DNA Centerによって検出されるデバイスの情報については、 Cisco DNA Center互換
性マトリクスを参照してください。

• Cisco DNA Centerとデバイス間の望ましいネットワーク遅延は 100ミリ秒のラウンドト
リップ時間（RTT）であることに注意してください（最大遅延は 200ミリ秒RTTです）。

• Cisco DNA Centerが使用できるように 1つ以上の SNMPクレデンシャルがデバイス上で設
定されていることを確認してください。少なくとも、これには SNMPv2C読み取りクレデ
ンシャルを使用できます。

• Cisco DNA Centerに検出させ、管理委させるデバイスの SSHクレデンシャルを設定しま
す。以下の基準のうち、少なくとも 1つが満たされる場合、Cisco DNA Centerはデバイス
を検出し、そのインベントリに追加します。

•デバイスへの SSHアクセスのために Cisco DNA Centerが使用するアカウントが、特
権 EXECモード（レベル 15）である。

•ディスカバリジョブで設定されるCLIクレデンシャルの一部としてデバイスのイネー
ブルパスワードを設定している。詳細については、設定のガイドラインと制限事項の

ディスカバリ（6ページ）を参照してください。
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優先管理 IPアドレス
Cisco DNA Centerでデバイスが検出されると、デバイスの IPアドレスの 1つが優先管理 IPア
ドレスとして使用されます。IPアドレスは、デバイスの組み込み管理インターフェイス、また
は別の物理インターフェイス、または Loopback0のような論理インターフェイスの IPアドレ
スにすることができます。デバイスのループバック IPアドレスを優先管理 IPアドレスとして
使用するために Cisco DNA Centerを設定できます（その IPアドレスが Cisco DNA Centerから
到達可能である場合）。

優先管理 IPアドレスとして [Use Loopback IP]を選択した場合、Cisco DNA Centerでは次のよ
うに優先管理 IPアドレスが指定されます。

•デバイスに 1つのループバックインターフェイスがある場合、Cisco DNACenterは、その
ループバックインターフェイスの IPアドレスを使用します。

•デバイスに複数のループバックインターフェイスがある場合、CiscoDNACenterは、最上
位の IPアドレスを持つループバックインターフェイスを使用します。

•ループバックインターフェイスがない場合、Cisco DNA Centerは、最上位の IPアドレス
を持つイーサネットインターフェイスを使用します（サブインターフェイスの IPアドレ
スは考慮されません）。

•イーサネットインターフェイスがない場合、Cisco DNA Centerは、最上位の IPアドレス
を持つシリアルインターフェイスを使用します

デバイスが検出された後に、[Inventory]ウィンドウから管理 IPアドレスを更新できます。

設定のガイドラインと制限事項のディスカバリ

Cisco DNA Centerによる Cisco Catalyst 3000シリーズスイッチおよび Catalyst 6000シリーズス
イッチの検出に関する注意事項と制約事項は、次のとおりです。

• CLIユーザ名およびパスワードは特権EXECモード（レベル15）で設定してください。こ
れらのログイン情報は、ディスカバリ機能に関してCiscoDNACenterで設定するCLIユー
ザー名およびパスワードと同じです。Cisco DNA Centerにはデバイスへの最高レベルのア
クセス権が必要です。

•着信接続と発信接続の両方に関して、個々のインターフェイスで許可されるトランスポー
トプロトコルを明示的に指定してください。この設定には、transport inputと transport
outputコマンドを使用してください。これらのコマンドについては、各デバイスタイプ
用のコマンドリファレンスドキュメントを参照してください。

•デバイスのコンソールポートと VTY回線のデフォルトのログイン方式を変更しないでく
ださい。デバイスがすでに AAA（TACACS）ログインで設定されている場合は、Cisco
DNA Centerで定義されている CLIログイン情報が、TACACSサーバで定義されている
TACACSログイン情報と同じであることを確認してください。
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•シスコワイヤレスコントローラは、サービスポート IPアドレスではなく、管理 IPアド
レスを使用して検出する必要があります。それ以外の場合は、関連するワイヤレスコント

ローラ 360および AP 360のウィンドウでは、データが表示されません。

CDPを使用したネットワークの検出
Cisco Discovery Protocol（CDP）IPアドレス範囲、または LLDPを使用してデバイスを検出で
きます。この手順では、CDPを使用してデバイスとホストを検出する方法を示します。

•ディスカバリ機能では、正しいSNMP読み取り専用コミュニティストリングが必要です。
SNMP読み取り専用コミュニティストリングが指定されていない場合、ベストエフォート
として、ディスカバリ機能はデフォルトのSNMP読み取り専用コミュニティストリングで
ある publicを使用します。

• CLIログイン情報はホストの検出には必要ありません。ホストは接続されているネット
ワークデバイスを介して検出されます。

（注）

始める前に

•ネットワークデバイスで CDPを有効にします。

•ディスカバリの前提条件（5ページ）で説明されているように、ネットワークデバイス
を設定します。

•クライアント IPアドレスとしてネットワークデバイスのホスト IPアドレスを設定しま
す。(A host is an end-user device, such as a laptop computer or mobile device.)

ステップ 1 メニューアイコン（ ）をクリックして、[Tools] > [Discovery]。

ステップ 2 [Discovery]ウィンドウで、[Add Discovery]をクリックします。

ステップ 3 [New Discovery]ウィンドウの [Discovery Name]フィールドに、名前を入力します。

ステップ 4 まだ表示されていない場合は [IP Address/Range]エリアを展開し、次のフィールドを設定します。

• [Discovery Type]：[CDP]オプションボタンをクリックして CDPを有効にします。

• [IP Address]：シード IPアドレスを入力し、Cisco DNA Centerでディスカバリスキャンを開始しま
す。

• [Subnet Filter]：ディスカバリスキャンから IPアドレスまたはサブネットを除外します。IPアドレス
を除外するには、個々の IPアドレス（x.x.x.x）を入力します。サブネットを除外するには、Classless
Inter-Domain Routing（CIDR）アドレス（x.x.x.x/y）を入力します。ここで、x.x.x.xは IPアドレス、y
はサブネットマスクです。サブネットマスクは、0～ 32の値です。

IPアドレスとサブネットをさらに除外するには、追加アイコン（ ）をクリックします。
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• [CDP Level]：スキャンするシードデバイスからのホップ数を入力します。

有効値は 1～ 16です。デフォルト値は 16です。たとえば、CDPレベル 3は、CDPがシードデバイ
スから最大 3つのホップまでスキャンすることを意味します。

• [Preferred Management IP Address]：次のいずれかのオプションボタンをクリックします。

• [None]：デバイスが任意の IPアドレスを使用できるようにします。

• [Use Loopback IP]：デバイスのループバックインターフェイスの IPアドレスを指定します。

[Use Loopback IP]の使用を選択し、デバイスにループバックインターフェイスがな
い場合、Cisco DNA Centerは優先管理 IPアドレス（6ページ）で説明されているロ
ジックを使用して、管理 IPアドレスを選択します。

（注）

ループバックインターフェイスの IPアドレスを優先管理 IPアドレスとして使用す
るには、CDPネイバーの IPアドレスがCisco DNACenterから到達可能であることを
確認します。

（注）

ステップ 5 [Credentials]エリアを展開し、使用するログイン情報を選択します。

すでに作成されているグローバルクレデンシャルのいずれかを選択するか、独自のディスカバリクレデ

ンシャルを設定します。

ステップ 6 既存のログイン情報を使用するには、使用するグローバルログイン情報を選択し、ステップ14に進みま
す。そのクレデンシャルを使用しない場合は、選択解除します。

ステップ 7 新しいログイン情報を設定するには、[Add Credentials]をクリックします。

自身のログイン情報を設定する場合は、[Save as global settings]チェックボックスをオンにし
て、将来の検出ジョブのためにそれらを保存できます。

（注）

ステップ 8 CLIクレデンシャルの場合は、次の手順を実行します。

a) 次のフィールドを設定します。

表 1 : CLIクレデンシャル

説明フィールド

CLIクレデンシャルを説明する名前または語句。Name/Description

ネットワーク内のデバイスのCLIにログインする
ために使用する名前。

Username
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説明フィールド

ネットワーク内のデバイスのCLIにログインする
ために使用されるパスワード。

セキュリティ上の理由から、確認のためにパス

ワードを再入力します。

パスワードはセキュリティ上の理由

から暗号化されており、この設定で

は表示されません。

（注）

Password

CLIで高い権限レベルに移るために使用するパス
ワード。ネットワークデバイスで必要な場合にの

み、このパスワードを設定します。

セキュリティ上の理由から、有効なパスワードを

再入力します。

パスワードはセキュリティ上の理由

から暗号化されており、この設定で

は表示されません。

（注）

Enable Password

b) これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェックボッ
クスをオンにします。このチェックボックスをオンにしない場合、ログイン情報は現在の検出ジョ

ブにのみ使用できます。

c) [Save]をクリックします。

ステップ 9 SNMP v2cログイン情報の場合は、[SNMP v2c]をクリックし、次の手順を実行します。

a) 次のフィールドを設定します。

表 2 : SNMPv2cのクレデンシャル

説明フィールド

• [Name/Description]：追加している SNMPv2c
設定の名前または説明。

• [ReadCommunity]：デバイスにSNMP情報を
表示する目的のみに使用される読み取り専用

のコミュニティ文字列パスワード。

パスワードはセキュリティ上の理由

から暗号化されており、この設定で

は表示されません。

（注）

Read
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説明フィールド

• [Name/Description]：追加している SNMPv2c
設定の名前または説明。

• [Write Community]：デバイス上の SNMP情
報を変更するために使用される書き込みコ

ミュニティ文字列。

パスワードはセキュリティ上の理由

から暗号化されており、この設定で

は表示されません。

（注）

Write

b) これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェックボッ
クスをオンにします。このチェックボックスをオンにしない場合、ログイン情報は現在の検出ジョ

ブにのみ使用できます。

c) [Save]をクリックします。

ステップ 10 （任意） SNMP v3ログイン情報の場合は、[SNMP v3]をクリックし、次の手順を実行します。

a) 次のフィールドを設定します。

表 3 : SNMPv3のクレデンシャル

説明フィールド

追加した SNMPv3設定の名前または説明。Name/Description

SNMPv3設定に関連付けられている名前。Username

SNMPメッセージを必要とするセキュリティレベル。次のいずれかのモードを
選択します。

• [noAuthNoPriv]：認証または暗号化を提供しません。

• [AuthNoPriv]：認証を提供しますが、暗号化は提供しません。

• [AuthPriv]：認証と暗号化の両方を提供します。

Mode

使用する認証タイプ（[Mode]として [AuthPriv]または [AuthNoPriv]を選択した
場合に有効になります）。次のいずれかの認証タイプを選択します。

• [SHA]：HMAC-SHAに基づく認証。

• [MD5]：HMAC-MD5に基づく認証。

Auth Type
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説明フィールド

SNMPv3を使用するデバイスから情報にアクセスする際に使用する SNMPv3パ
スワード。これらのパスワード（またはパスフレーズ）は、8文字以上にする
必要があります。

（注） •一部のシスコワイヤレスコントローラでは、パスワード（あ
るいはパスフレーズ）は少なくとも 12文字以上である必要が
あります。ワイヤレスコントローラのパスワードの最小要件を

必ず確認してください。パスワードに必要な最低限の文字数が

守られないと、デバイスではCisco DNA Centerによる検出、監
視、管理が行われなくなります。

•パスワードはセキュリティ上の理由から暗号化されており、こ
の設定では表示されません。

Auth Password

プライバシータイプ。（[Mode]として [AuthPriv]を選択した場合に有効になり
ます）。次のいずれかのプライバシータイプを選択します。

• [AES128]：暗号化の 128ビット CBCモード AES。

• CISCOAES192：シスコのデバイス上での暗号化の 192ビット CBCモード
AES。

• CISCOAES256：シスコのデバイス上での暗号化の 256ビット CBCモード
AES。

（注） •検出機能とインベントリ機能の使用は、プライバシータイプ
CISCOAES192および CISCOAES256のみでサポートされてい
ます。アシュアランス機能はサポートされていません。

•プライバシータイプAES128は、検出、インベントリ、および
アシュアランスでサポートされています。

Privacy Type

暗号化の標準規格をサポートしているデバイスで交換されるメッセージを暗号

化するための秘密鍵を生成するために使用される SNMPv3プライバシーパス
ワード。パスワード（またはパスフレーズ）は、8文字以上にする必要があり
ます。

（注） •一部のシスコワイヤレスコントローラでは、パスワード（あ
るいはパスフレーズ）は少なくとも 12文字以上である必要が
あります。ワイヤレスコントローラのパスワードの最小要件を

必ず確認してください。パスワードに必要な最低限の文字数が

守られないと、デバイスではCisco DNA Centerによる検出、監
視、管理が行われなくなります。

•パスワードはセキュリティ上の理由から暗号化されており、こ
の設定では表示されません。

Privacy Password
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b) これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェックボッ
クスをオンにします。このチェックボックスをオンにしない場合、ログイン情報は現在の検出ジョ

ブにのみ使用できます。

c) [Save]をクリックします。

ステップ 11 （任意） SNMPプロパティを設定するには、[SNMP PROPERTIES]をクリックし、次の手順を実行しま
す。

a) 次のフィールドを設定します。

表 4 : SNMPのプロパティ

説明フィールド

Cisco DNA Centerが SNMPを使用してネットワークデバイスとの通信
を試行する回数。

Retries

再試行の時間間隔（秒単位）。Timeout

b) これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェックボッ
クスをオンにします。このチェックボックスをオンにしない場合、ログイン情報は現在の検出ジョ

ブにのみ使用できます。

c) [Save]をクリックします。

ステップ 12 （任意） HTTPログイン情報を設定するには、[HTTP（S）]をクリックし、次の手順を実行します。

a) 次のフィールドを設定します。

表 5 : HTTPSクレデンシャル

説明フィールド

設定している HTTPSクレデンシャルのタイプを
指定します。有効なタイプは、[Read]または
[White]です。

Type
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説明フィールド

最大10個のHTTPS読み取りまたは書き込みクレ
デンシャルを設定できます。

• [Name/Description]：追加している HTTPSロ
グイン情報の名前または説明。

• [Username]：HTTPS接続の認証に使用される
名前です。

• [Password]：HTTPS接続の認証に使用される
パスワードです。パスワードはセキュリティ

上の理由から暗号化されており、この設定で

は表示されません。

• [Port]：HTTPSトラフィックに使用される
TCP/UDPポートの番号です。デフォルトは
ポート番号443（HTTPSの既知のポート）で
す。

パスワードは 7～ 128文字で指定します。次から
少なくとも 1つずつ使用する必要があります。

•小文字の英字（a～ z）

•大文字の英字（A～ Z）

•数字（0～ 9）

•特殊文字（: # _ * ?）–

パスワードにスペースや山カッコ（< >）は使用
できません。一部のCisco IOSXEデバイスでは、
疑問符（?）を使用できないので注意してくださ
い。

Read/Write

b) （任意）これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェッ
クボックスをオンにします。このチェックボックスをオンにしない場合、ログイン情報は現在の検

出ジョブにのみ使用できます。

c) [Save]をクリックします。

ステップ 13 （任意） NETCONFが有効になっているネットワークデバイスがあり、Cisco DNA Centerで NETCONF
を使用してそれらのデバイスの構成をインストール、操作、および削除する場合は、[NETCONF]をク
リックして次の手順を実行します。

a) [Port]フィールドに、ポート番号を入力します。次のいずれかのポートを使用できます。

•ポート 830（デフォルト）

•デバイスで使用可能なその他のポート

アシュアランスを使用するための Cisco DNA Centerの設定
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• CiscoDNACenterで設定されたカスタムポート（デバイスの可制御性が有効な場合のみカスタム
ポートを使用できます。詳細については、Cisco DNA Center管理者ガイドの「Device
Controllability」の項を参照してください

）。

[Add Discovery]ウィンドウの [Advanced]エリアで [Telnet]プロトコルを選択すると、
NETCONFは無効になります。

（注）

CiscoCatalyst 9800シリーズワイヤレスコントローラデバイスを検出するには、NETCONF
を有効にする必要があります。

（注）

b) これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェックボッ
クスをオンにします。このチェックボックスをオンにしない場合、ログイン情報は現在の検出ジョ

ブにのみ使用できます。

c) [Save]をクリックします。

ステップ 14 （任意）デバイスとの接続に使用されるプロトコルを設定するには、[Advanced]エリアを展開し、次の
手順を実行します。

a) 使用するプロトコルの名前をクリックします。緑のチェックマークはプロトコルが選択されている
ことを示します。

有効なプロトコルは、[SSH]（デフォルト）および [Telnet]です。

b) 使用する順序でプロトコルをドラッグアンドドロップします。

[AddDiscovery]ウィンドウの [Advanced]エリアで [Telnet]プロトコルを選択すると、NETCONF
は無効になります。

（注）

ステップ 15 [Discover]をクリックします。

ステップ 16 今すぐ検出を実行するには、[Discover Devices]スライドインペインで [Now]オプションボタンをクリッ
クし、[Start]をクリックします。それ以外の場合は、次のステップに進みます。

新しいデバイスのみを検出する場合は、[Discover only new devices]トグルボタンをクリックします。

ステップ 17 後で検出するようにスケジュールを設定するには、次の手順を実行します。

1. [Later]ラジオボタンをクリックします。

2. 開始日時を定義します。

3. [Time Zone]ドロップダウンリストから、タイムゾーンを選択します。

4. [Recurrence]領域で、[None]、[Daily]、または [Weekly]をクリックします。

• [None]：検出は繰り返されません。

• [Daily]：[Run at Interval（Days）]フィールドに間隔を日単位で入力します。

• [Weekly]:[Run at Interval（Weeks）]フィールドに間隔を週単位で入力します。
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5. 繰り返しに [Daily]または [Weekly]を選択した場合は、[Set Schedule End]チェックボックスをオンに
して終了日時を定義します。

繰り返しでは、新しいデバイスのみを検出できます。上部に表示される [Discoveronlynew
devices]トグルボタンは、デフォルトで有効になっています。

（注）

6. [End Date]または [End After]をクリックします。

• [End Date]：繰り返しを終了する月、日付、年を入力します。

• [End After]：繰り返しを終了するまでの回数を入力します。

7. [Start]をクリックします。

通知アイコンをクリックして、スケジュールされた検出を表示します。検出を開始する前に、[Edit]をク
リックして編集するか、または [Cancel]をクリックしてキャンセルできます。

[Discoveries]ウィンドウにスキャンの結果が表示されます。

[Discovery Details]ペインに、ステータス（アクティブまたは非アクティブ）および検出設定が表示され
ます。[デバイスのディスカバリ（DiscoveryDevices）]ペインに、検出されたデバイスのホスト名、IPア
ドレス、ステータスが表示されます。

IPアドレス範囲を使用したネットワークの検出
IPアドレス範囲、CDP、またはLLDPを使用してデバイスを検出できます。この手順では、IP
アドレス範囲を使用してデバイスとホストを検出する方法を示します。

始める前に

ディスカバリの前提条件（5ページ）で説明されているように、デバイスには必須のデバイ
ス設定が存在する必要があります。

ステップ 1 メニューアイコン（ ）をクリックして、[Tools] > [Discovery]。

ステップ 2 [Discovery]ウィンドウで、[Add Discovery]をクリックします。

ステップ 3 [New Discovery]ウィンドウの [Discovery Name]フィールドに、名前を入力します。

ステップ 4 まだ表示されていない場合は [IP Address/Ranges]エリアを展開し、次のフィールドを設定します。

• [Discovery Type]：[IP Address/Range]オプションボタンをクリックし、IPアドレスまたはアドレス範
囲を使用してデバイスを検出します。

• [From]および [To]フィールド：[From]フィールドに開始 IPアドレスを入力し、[To]フィールドに
終了 IPアドレスを入力します。

IPアドレス範囲を追加するには、追加アイコン（[+]）をクリックします。
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Ciscoワイヤレスコントローラは、サービスポート IPアドレスではなく、管理 IPアド
レスを使用して検出する必要があります。それ以外の場合は、関連するワイヤレスコン

トローラ 360および AP 360のウィンドウでは、データが表示されません。

（注）

• [Subnet Filter]：ディスカバリスキャンから IPアドレスまたはサブネットを除外します。IPアドレス
を除外するには、個々の IPアドレス（x.x.x.x）を入力します。サブネットを除外するには、Classless
Inter-Domain Routing（CIDR）アドレス（x.x.x.x/y）を入力します。ここで、x.x.x.xは IPアドレス、y
はサブネットマスクです。サブネットマスクは、0～ 32の値です。

IPアドレスとサブネットをさらに除外するには、追加アイコン（ ）をクリックします。

• [Preferred Management IP Address]：次のいずれかのオプションボタンをクリックします。

• [None]：デバイスが任意の IPアドレスを使用できるようにします。

• [Use Loopback IP]：デバイスのループバックインターフェイスの IPアドレスを指定します。

[Use Loopback IP]の使用を選択し、デバイスにループバックインターフェイスがな
い場合、Cisco DNA Centerは優先管理 IPアドレス（6ページ）で説明されているロ
ジックを使用して、管理 IPアドレスを選択します。

（注）

ステップ 5 [Credentials]エリアを展開し、使用するログイン情報を選択します。

すでに作成されているグローバルクレデンシャルのいずれかを選択するか、独自のディスカバリクレデ

ンシャルを設定します。

ステップ 6 既存のログイン情報を使用するには、使用するグローバルログイン情報を選択し、ステップ14に進みま
す。そのクレデンシャルを使用しない場合は、選択解除します。

ステップ 7 新しいログイン情報を設定するには、[Add Credentials]をクリックします。

自身のログイン情報を設定する場合は、[Save as global settings]チェックボックスをオンにし
て、将来の検出ジョブのためにそれらを保存できます。

（注）

ステップ 8 CLIクレデンシャルの場合は、次の手順を実行します。

a) 次のフィールドを設定します。

表 6 : CLIクレデンシャル

説明フィールド

CLIクレデンシャルを説明する名前または語句。Name/Description

ネットワーク内のデバイスのCLIにログインするために使用する名前。Username

ネットワーク内のデバイスの CLIにログインするために使用されるパ
スワード。

セキュリティ上の理由から、確認のためにパスワードを再入力します。

パスワードはセキュリティ上の理由から暗号化されてお

り、この設定では表示されません。

（注）

Password
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説明フィールド

CLIで高い権限レベルに移るために使用するパスワード。ネットワー
クデバイスで必要な場合にのみ、このパスワードを設定します。

セキュリティ上の理由から、有効なパスワードを再入力します。

パスワードはセキュリティ上の理由から暗号化されてお

り、この設定では表示されません。

（注）

Enable Password

b) これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェックボッ
クスをオンにします。このチェックボックスをオンにしなかった場合、ログイン情報を使用できる

のは現在の検出ジョブに対してのみです。

c) [Save]をクリックします。

ステップ 9 SNMP v2cログイン情報の場合は、[SNMP v2c]をクリックし、次の手順を実行します。

a) 次のフィールドを設定します。

表 7 : SNMPv2cのクレデンシャル

説明フィールド

• [Name/Description]：追加している SNMPv2c設定の名前または説明。

• [Read Community]：デバイスに SNMP情報を表示する目的のみに使用され
る読み取り専用のコミュニティ文字列パスワード。

パスワードはセキュリティ上の理由から暗号化されており、この設

定では表示されません。

（注）

Read

• [Name/Description]：追加している SNMPv2c設定の名前または説明。

• [Write Community]：デバイス上の SNMP情報を変更するために使用される
書き込みコミュニティ文字列。

パスワードはセキュリティ上の理由から暗号化されており、この設

定では表示されません。

（注）

Write

b) これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェックボッ
クスをオンにします。このチェックボックスをオンにしなかった場合、ログイン情報を使用できる

のは現在の検出ジョブに対してのみです。

c) [Save]をクリックします。

ステップ 10 （任意） SNMP v3ログイン情報の場合は、[SNMP v3]をクリックし、次の手順を実行します。

a) 次のフィールドを設定します。
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表 8 : SNMPv3のクレデンシャル

説明フィールド

追加した SNMPv3設定の名前または説明。Name/Description

SNMPv3設定に関連付けられている名前。Username

SNMPメッセージを必要とするセキュリティレベル。次のいずれかのモードを
選択します。

• [noAuthNoPriv]：認証または暗号化を提供しません。

• [AuthNoPriv]：認証を提供しますが、暗号化は提供しません。

• [AuthPriv]：認証と暗号化の両方を提供します。

Mode

使用する認証タイプ（[Mode]として [AuthPriv]または [AuthNoPriv]を選択した
場合に有効になります）。次のいずれかの認証タイプを選択します。

• [SHA]：HMAC-SHAに基づく認証。

• [MD5]：HMAC-MD5に基づく認証。

Auth Type

SNMPv3を使用するデバイスから情報にアクセスする際に使用する SNMPv3パ
スワード。これらのパスワード（またはパスフレーズ）は、8文字以上にする
必要があります。

（注） •一部のシスコワイヤレスコントローラでは、パスワード（あ
るいはパスフレーズ）は少なくとも 12文字以上である必要が
あります。ワイヤレスコントローラのパスワードの最小要件を

必ず確認してください。パスワードに必要な最低限の文字数が

守られないと、デバイスではCisco DNA Centerによる検出、監
視、管理が行われなくなります。

•パスワードはセキュリティ上の理由から暗号化されており、こ
の設定では表示されません。

Auth Password
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説明フィールド

プライバシータイプ。（[Mode]として [AuthPriv]を選択した場合に有効になり
ます）。次のいずれかのプライバシータイプを選択します。

• [AES128]：暗号化の 128ビット CBCモード AES。

• CISCOAES192：シスコのデバイス上での暗号化の 192ビット CBCモード
AES。

• CISCOAES256：シスコのデバイス上での暗号化の 256ビット CBCモード
AES。

（注） •検出機能とインベントリ機能の使用は、プライバシータイプ
CISCOAES192および CISCOAES256のみでサポートされてい
ます。アシュアランス機能はサポートされていません。

•プライバシータイプAES128は、検出、インベントリ、および
アシュアランスでサポートされています。

Privacy Type

暗号化の標準規格をサポートしているデバイスで交換されるメッセージを暗号

化するための秘密鍵を生成するために使用される SNMPv3プライバシーパス
ワード。パスワード（またはパスフレーズ）は、8文字以上にする必要があり
ます。

（注） •一部のシスコワイヤレスコントローラでは、パスワード（あ
るいはパスフレーズ）は少なくとも 12文字以上である必要が
あります。ワイヤレスコントローラのパスワードの最小要件を

必ず確認してください。パスワードに必要な最低限の文字数が

守られないと、デバイスではCisco DNA Centerによる検出、監
視、管理が行われなくなります。

•パスワードはセキュリティ上の理由から暗号化されており、こ
の設定では表示されません。

Privacy Password

b) これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェックボッ
クスをオンにします。このチェックボックスをオンにしなかった場合、ログイン情報を使用できる

のは現在の検出ジョブに対してのみです。

c) [Save]をクリックします。

ステップ 11 （任意） SNMPプロパティを設定するには、[SNMP PROPERTIES]をクリックし、次の手順を実行しま
す。

a) 次のフィールドを設定します。
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表 9 : SNMPのプロパティ

説明フィールド

Cisco DNA Centerが SNMPを使用してネットワークデバイスとの通信
を試行する回数。

Retries

再試行の時間間隔（秒単位）。Timeout

b) これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェックボッ
クスをオンにします。このチェックボックスをオンにしなかった場合、ログイン情報を使用できる

のは現在の検出ジョブに対してのみです。

c) [Save]をクリックします。

ステップ 12 （任意） HTTPログイン情報を設定するには、[HTTP（S）]をクリックし、次の手順を実行します。

a) 次のフィールドを設定します。

表 10 : HTTPSクレデンシャル

説明フィールド

設定しているHTTPSクレデンシャルのタイプを指定します。有効なタイプは、
[Read]または [White]です。

Type

最大 10つの HTTPS読み取りクレデンシャルを設定できます。

• [Name/Description]：追加しているHTTPSログイン情報の名前または説明。

• [Username]：HTTPS接続の認証に使用される名前です。

• [Password]：HTTPS接続の認証に使用されるパスワードです。パスワード
はセキュリティ上の理由から暗号化されており、この設定では表示されま

せん。

• [Port]：HTTPSトラフィックに使用される TCP/UDPポートの番号です。デ
フォルトはポート番号 443（HTTPSの既知のポート）です。

パスワードは 7～ 128文字で指定します。次から少なくとも 1つずつ使用する
必要があります。

•小文字の英字（a～ z）

•大文字の英字（A～ Z）

•数字（0～ 9）

•特殊文字（: # _ * ?）–

パスワードにスペースや山カッコ（< >）は使用できません。一部の Cisco IOS
XEデバイスでは、疑問符（?）を使用できないので注意してください。

Read
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説明フィールド

最大 10つの HTTPS書き込みクレデンシャルを設定できます。

• [Name/Description]：追加しているHTTPSログイン情報の名前または説明。

• [Username]：HTTPS接続の認証に使用される名前です。

• [Password]：HTTPS接続の認証に使用されるパスワードです。パスワード
はセキュリティ上の理由から暗号化されており、この設定では表示されま

せん。

• [Port]：HTTPSトラフィックに使用される TCP/UDPポートの番号です。デ
フォルトはポート番号 443（HTTPSの既知のポート）です。

パスワードは 7～ 128文字で指定します。次から少なくとも 1つずつ使用する
必要があります。

•小文字の英字（a～ z）

•大文字の英字（A～ Z）

•数字（0～ 9）

•特殊文字（: # _ * ?）–

パスワードにスペースや山カッコ（< >）は使用できません。一部の Cisco IOS
XEデバイスでは、疑問符（?）を使用できないので注意してください。

Write

b) （任意）これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェッ
クボックスをオンにします。このチェックボックスをオンにしなかった場合、ログイン情報を使用

できるのは現在の検出ジョブに対してのみです。

c) [Save]をクリックします。

ステップ 13 （任意） NETCONFが有効になっているネットワークデバイスがあり、Cisco DNA Centerで NETCONF
を使用してそれらのデバイスの構成をインストール、操作、および削除する場合は、[NETCONF]をク
リックして次の手順を実行します。

a) [Port]フィールドに、ポート番号を入力します。次のいずれかのポートを使用できます。

•ポート 830（デフォルト）

•デバイスで使用可能なその他のポート

• CiscoDNACenterで構成するカスタムポート。（デバイス可制御性が有効になっている場合にの
み、カスタムポートを使用できます詳細については、Cisco DNA Center管理者ガイドの「Device
Controllability」の項を参照してください

[Add Discovery]ウィンドウの [Advanced]エリアで [Telnet]プロトコルを選択すると、
NETCONFは無効になります。

（注）
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CiscoCatalyst 9800シリーズワイヤレスコントローラデバイスを検出するには、NETCONF
を有効にする必要があります。

（注）

b) これらのログイン情報を後で使用するために保存する場合は、[Save as global settings]チェックボッ
クスをオンにします。このチェックボックスをオンにしなかった場合、ログイン情報を使用できる

のは現在の検出ジョブに対してのみです。

c) [Save]をクリックします。

ステップ 14 （任意）デバイスとの接続に使用されるプロトコルを設定するには、[Advanced]エリアを展開し、次の
手順を実行します。

a) 使用するプロトコルの名前をクリックします。緑のチェックマークはプロトコルが選択されている
ことを示します。

有効なプロトコルは、[SSH]（デフォルト）および [Telnet]です。

b) 使用する順序でプロトコルをドラッグアンドドロップします。

[AddDiscovery]ウィンドウの [Advanced]エリアで [Telnet]プロトコルを選択すると、NETCONF
は無効になります。

（注）

ステップ 15 [Discover]をクリックします。

ステップ 16 今すぐ検出を実行するには、[Now]ラジオボタンをクリックし、[Start]をクリックします。それ以外の場
合は、次のステップに進みます。

新しいデバイスのみを検出する場合は、[Discover only new devices]トグルボタンをクリックします。

ステップ 17 後で検出するようにスケジュールを設定するには、次の手順を実行します。

1. [Later]ラジオボタンをクリックします。

2. 開始日時を定義します。

3. [Time Zone]ドロップダウンリストから、タイムゾーンを選択します。

4. [Recurrence]領域で、[None]、[Daily]、または [Weekly]をクリックします。

• [None]：検出は繰り返されません。

• [Daily]：[Run at Interval（Days）]フィールドに間隔を日単位で入力します。

• [Weekly]:[Run at Interval（Weeks）]フィールドに間隔を週単位で入力します。

5. 繰り返しに [Daily]または [Weekly]を選択した場合は、[Set Schedule End]チェックボックスをオンに
して終了日時を定義します。

繰り返しでは、新しいデバイスのみを検出できます。上部に表示される [Discoveronlynew
devices]トグルボタンは、デフォルトで有効になっています。

（注）

6. [End Date]または [End After]をクリックします。

• [End Date]：繰り返しを終了する月、日付、年を入力します。

• [End After]：繰り返しを終了するまでの回数を入力します。
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7. [Start]をクリックします。

通知アイコンをクリックして、スケジュールされた検出を表示します。検出を開始する前に、[Edit]をク
リックして編集するか、または [Cancel]をクリックしてキャンセルできます。

[Discoveries]ウィンドウにスキャンの結果が表示されます。

[Discovery Details]ペインに、ステータス（アクティブまたは非アクティブ）および検出設定が表示され
ます。[DiscoveryDevices]ペインに、検出されたデバイスのホスト名、IPアドレス、ステータスが表示さ
れます。

LLDPを使用したネットワークの検出
Link Layer Discovery Protocol（LLDP）、CDP、または IPアドレス範囲を使用してデバイスを
検出できます。この手順では、LLDPを使用してデバイスとホストを検出する方法を示します。

•検出には、SNMP読み取り専用コミュニティストリングが必要です。SNMP読み取り専用
コミュニティストリングが指定されていない場合、ベストエフォートとして、検出ではデ

フォルトの SNMP読み取り専用コミュニティストリングである publicが使用されます。

• CLIログイン情報はホストの検出には必要ありません。ホストは接続されているネット
ワークデバイスを介して検出されます。

（注）

始める前に

•ネットワークデバイスで LLDPを有効にします。

•ディスカバリの前提条件（5ページ）で説明されているように、ネットワークデバイス
を設定します。

•クライアント IPアドレスとしてネットワークデバイスのホストの IPアドレスを設定しま
す。(A host is an end-user device, such as a laptop computer or mobile device.)

ステップ 1 メニューアイコン（ ）をクリックして、[Tools] > [Discovery]。

ステップ 2 [Discovery]ウィンドウで、[Add Discovery]をクリックします。

ステップ 3 [New Discovery]ウィンドウの [Discovery Name]フィールドに、名前を入力します。

ステップ 4 まだ表示されていない場合は [IP Address/Range]エリアを展開し、次のフィールドを設定します。

• [Discovery Type]：[LLDP]オプションボタンをクリックして LLDPを有効にします。

• [IP Address]：シード IPアドレスを入力し、Cisco DNA Centerでディスカバリスキャンを開始します。
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• [Subnet Filter]：ディスカバリスキャンから IPアドレスまたはサブネットを除外します。IPアドレスを
除外するには、個々の IPアドレス（x.x.x.x）を入力します。サブネットを除外するには、Classless
Inter-Domain Routing（CIDR）アドレス（x.x.x.x/y）を入力します。ここで、x.x.x.xは IPアドレス、yは
サブネットマスクです。サブネットマスクは、0～ 32の値です。

IPアドレスとサブネットをさらに除外するには、追加アイコン（ ）をクリックします。

• [LLDP Level]：スキャンするシードデバイスからのホップ数を入力します。

有効値は 1～ 16です。デフォルト値は 16です。たとえば、CDPレベル 3は、CDPがシードデバイス
から最大 3つのホップまでスキャンすることを意味します。

• [Preferred Management IP Address]：次のいずれかのオプションボタンをクリックします。

• [None]：デバイスが任意の IPアドレスを使用できるようにします。

• [Use Loopback IP]：デバイスのループバックインターフェイスの IPアドレスを指定します。

[Use Loopback IP]の使用を選択し、デバイスにループバックインターフェイスがない
場合、Cisco DNA Centerは優先管理 IPアドレス（6ページ）で説明されているロジッ
クを使用して、管理 IPアドレスを選択します。

（注）

ループバックインターフェイスの IPアドレスを優先管理 IPアドレスとして使用する
には、LLDPネイバーの IPアドレスが Cisco DNA Centerから到達可能であることを確
認します。

（注）

ステップ 5 [Credentials]エリアを展開し、ディスカバリジョブで使用するクレデンシャルを設定します。

すでに作成されているグローバルクレデンシャルのいずれかを選択するか、独自のディスカバリクレデン

シャルを設定します。クレデンシャルを設定する場合は、[Save as global settings]チェックボックスをオン
にして、将来のジョブのためにそれらを保存できます。

a) 使用するグローバルクレデンシャルが選択されていることを確認します。そのクレデンシャルを使用
しない場合は、選択解除します。

b) 別のクレデンシャルを追加するには、[Add Credentials]をクリックします。
c) CLIクレデンシャルの場合は、次のフィールドを設定します。

表 11 : CLIクレデンシャル

説明フィールド

CLIクレデンシャルを説明する名前または語句。Name/Description

ネットワーク内のデバイスのCLIにログインするために使用する名前。Username

ネットワーク内のデバイスのCLIにログインするために使用されるパス
ワード。

セキュリティ上の理由から、確認のためにパスワードを再入力します。

パスワードはセキュリティ上の理由から暗号化されており、

この設定では表示されません。

（注）

Password
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説明フィールド

CLIで高い権限レベルに移るために使用するパスワード。ネットワーク
デバイスで必要な場合にのみ、このパスワードを設定します。

セキュリティ上の理由から、有効なパスワードを再入力します。

パスワードはセキュリティ上の理由から暗号化されており、

この設定では表示されません。

（注）

Enable Password

d) [SNMP v2c]をクリックして、次のフィールドを設定します。

表 12 : SNMPv2cのクレデンシャル

説明フィールド

• [Name/Description]：追加している SNMPv2c設定の名前または説明。

• [Read Community]：デバイスに SNMP情報を表示する目的のみに使用される
読み取り専用のコミュニティ文字列パスワード。

パスワードはセキュリティ上の理由から暗号化されており、この設定

では表示されません。

（注）

Read

• [Name/Description]：追加している SNMPv2c設定の名前または説明。

• [WriteCommunity]：デバイス上のSNMP情報を変更するために使用される書
き込みコミュニティ文字列。

パスワードはセキュリティ上の理由から暗号化されており、この設定

では表示されません。

（注）

Write

e) （任意） [SNMP v3]をクリックして、次のフィールドを設定します。

表 13 : SNMPv3のクレデンシャル

説明フィールド

追加した SNMPv3設定の名前または説明。Name/Description

SNMPv3設定に関連付けられている名前。Username

SNMPメッセージを必要とするセキュリティレベル。次のいずれかのモードを選
択します。

• [noAuthNoPriv]：認証または暗号化を提供しません。

• [AuthNoPriv]：認証を提供しますが、暗号化は提供しません。

• [AuthPriv]：認証と暗号化の両方を提供します。

Mode
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説明フィールド

使用する認証タイプ（[Mode]として [AuthPriv]または [AuthNoPriv]を選択した場
合に有効になります）。次のいずれかの認証タイプを選択します。

• [SHA]：HMAC-SHAに基づく認証。

• [MD5]：HMAC-MD5に基づく認証。

Auth Type

SNMPv3を使用するデバイスから情報にアクセスする際に使用するSNMPv3パス
ワード。これらのパスワード（またはパスフレーズ）は、8文字以上にする必要
があります。

（注） •一部のシスコワイヤレスコントローラでは、パスワード（ある
いはパスフレーズ）は少なくとも 12文字以上である必要があり
ます。ワイヤレスコントローラのパスワードの最小要件を必ず

確認してください。パスワードに必要な最低限の文字数が守られ

ないと、デバイスではCisco DNA Centerによる検出、監視、管理
が行われなくなります。

•パスワードはセキュリティ上の理由から暗号化されており、この
設定では表示されません。

Auth Password

プライバシータイプ。（[Mode]として [AuthPriv]を選択した場合に有効になりま
す）。次のいずれかのプライバシータイプを選択します。

• [AES128]：暗号化の 128ビット CBCモード AES。

• CISCOAES192：シスコのデバイス上での暗号化の 192ビット CBCモード
AES。

• CISCOAES256：シスコのデバイス上での暗号化の 256ビット CBCモード
AES。

（注） •検出機能とインベントリ機能の使用は、プライバシータイプ
CISCOAES192および CISCOAES256のみでサポートされていま
す。アシュアランス機能はサポートされていません。

•プライバシータイプ AES128は、検出、インベントリ、および
アシュアランスでサポートされています。

Privacy Type
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説明フィールド

暗号化の標準規格をサポートしているデバイスで交換されるメッセージを暗号化

するための秘密鍵を生成するために使用される SNMPv3プライバシーパスワー
ド。パスワード（またはパスフレーズ）は、8文字以上にする必要があります。

（注） •一部のシスコワイヤレスコントローラでは、パスワード（ある
いはパスフレーズ）は少なくとも 12文字以上である必要があり
ます。ワイヤレスコントローラのパスワードの最小要件を必ず

確認してください。パスワードに必要な最低限の文字数が守られ

ないと、デバイスではCisco DNA Centerによる検出、監視、管理
が行われなくなります。

•パスワードはセキュリティ上の理由から暗号化されており、この
設定では表示されません。

Privacy Password

f) （任意） [SNMP PROPERTIES]をクリックして、次のフィールドを設定します。

表 14 : SNMPのプロパティ

説明フィールド

Cisco DNA Centerが SNMPを使用してネットワークデバイスとの通信を
試行する回数。

Retries

再試行間隔を表す秒数。Timeout

g) （任意） [HTTP（S）]をクリックして、次のフィールドを設定します。

表 15 : HTTPSクレデンシャル

説明フィールド

設定している HTTPSクレデンシャルのタイプを指定します。有効なタイプは、
[Read]または [White]です。

Type

アシュアランスを使用するための Cisco DNA Centerの設定
27

アシュアランスを使用するための Cisco DNA Centerの設定

LLDPを使用したネットワークの検出



説明フィールド

最大 10つの HTTPS読み取りクレデンシャルを設定できます。

• [Name/Description]：追加している HTTPSログイン情報の名前または説明。

• [Username]：HTTPS接続の認証に使用される名前です。

• [Password]：HTTPS接続の認証に使用されるパスワードです。パスワードは
セキュリティ上の理由から暗号化されており、この設定では表示されませ

ん。

• [Port]：HTTPSトラフィックに使用される TCP/UDPポートの番号です。デ
フォルトはポート番号 443（HTTPSの既知のポート）です。

パスワードは 7～ 128文字で指定します。次から少なくとも 1つずつ使用する必
要があります。

•小文字の英字（a～ z）

•大文字の英字（A～ Z）

•数字（0～ 9）

•特殊文字（: # _ * ?）–

パスワードにスペースや山カッコ（<>）は使用できません。一部のCiscoIOSXE
デバイスでは、疑問符（?）を使用できないので注意してください。

Read
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説明フィールド

最大 10つの HTTPS書き込みクレデンシャルを設定できます。

• [Name/Description]：追加している HTTPSログイン情報の名前または説明。

• [Username]：HTTPS接続の認証に使用される名前です。

• [Password]：HTTPS接続の認証に使用されるパスワードです。パスワードは
セキュリティ上の理由から暗号化されており、この設定では表示されませ

ん。

• [Port]：HTTPSトラフィックに使用される TCP/UDPポートの番号です。デ
フォルトはポート番号 443（HTTPSの既知のポート）です。

パスワードは 7～ 128文字で指定します。次から少なくとも 1つずつ使用する必
要があります。

•小文字の英字（a～ z）

•大文字の英字（A～ Z）

•数字（0～ 9）

•特殊文字（: # _ * ?）–

パスワードにスペースや山カッコ（<>）は使用できません。一部のCiscoIOSXE
デバイスでは、疑問符（?）を使用できないので注意してください。

Write

ステップ 6 （任意）デバイスとの接続に使用されるプロトコルを設定するには、[詳細（Advanced）]エリアを展開
し、次のタスクを実行します。

a) 使用するプロトコルの名前をクリックします。緑のチェックマークはプロトコルが選択されているこ
とを示します。有効なプロトコルは、[SSH]（デフォルト）および [Telnet]です。

b) 使用する順序でプロトコルをドラッグアンドドロップします。

ステップ 7 [Discover]をクリックします。

[Discover Devices]スライドインペインが表示されます。

ステップ 8 今すぐ検出を実行するには、[Now]ラジオボタンをクリックし、[Start]をクリックします。

新しいデバイスのみを検出する場合は、[Discover only new devices]トグルボタンをクリックします。

ステップ 9 後で検出するようにスケジュールを設定するには、次の手順を実行します。

1. [Later]ラジオボタンをクリックします。

2. 開始日時を定義します。

3. [Time Zone]ドロップダウンリストから、タイムゾーンを選択します。

4. [Recurrence]領域で、[None]、[Daily]、または [Weekly]をクリックします。
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• [None]：検出は繰り返されません。

• [Daily]：[Run at Interval（Days）]フィールドに間隔を日単位で入力します。

• [Weekly]:[Run at Interval（Weeks）]フィールドに間隔を週単位で入力します。

5. 繰り返しに [Daily]または [Weekly]を選択した場合は、[Set Schedule End]チェックボックスをオンにし
て終了日時を定義します。

繰り返しでは、新しいデバイスのみを検出できます。上部に表示される [Discover only new
devices]トグルボタンは、デフォルトで有効になっています。

（注）

6. [End Date]または [End After]をクリックします。

• [End Date]：繰り返しを終了する月、日付、年を入力します。

• [End After]：繰り返しを終了するまでの回数を入力します。

7. [Start]をクリックします。

通知アイコンをクリックして、スケジュールされた検出を表示します。検出を開始する前に、[Edit]をク
リックして編集するか、または [Cancel]をクリックしてキャンセルできます。

[Discoveries]ウィンドウにスキャンの結果が表示されます。

[Discovery Details]ペインに、ステータス（アクティブまたは非アクティブ）および検出設定が表示されま
す。[デバイスのディスカバリ（DiscoveryDevices）]ペインに、検出されたデバイスのホスト名、IPアドレ
ス、ステータスが表示されます。

ディスカバリジョブの管理

ここでは、ディスカバリジョブの管理方法について説明します。

ディスカバリジョブの停止および開始

ステップ 1 メニューアイコン（ ）をクリックして、[Tools] > [Discovery]。

ステップ 2 [Discovery]ウィンドウで、[All discoveries page from previous release]をクリックします。

ステップ 3 アクティブなディスカバリジョブを停止するには、次の手順を実行します。

a) 左側の [Discoveries]ペインで、ディスカバリジョブをクリックします。
b) 下部ペインの右側で、[Stop]をクリックします。

ステップ 4 非アクティブなディスカバリジョブを再起動するには、次の手順を実行します。

a) 左側の [Discoveries]ペインで、ディスカバリジョブをクリックします。
b) 下部ペインの右側で、[Re-discover]をクリックします。
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ディスカバリジョブの複製

ディスカバリジョブを複製し、そのジョブ用に定義されているすべての情報を保持できます。

始める前に

少なくとも 1つのディスカバリジョブを実行する必要があります。

ステップ 1 メニューアイコン（ ）をクリックして、[Tools] > [Discovery]。

ステップ 2 [Discovery]ウィンドウで、[All discoveries page from previous release]をクリックします。

ステップ 3 左側の [Discoveries]ペインで、ディスカバリジョブをクリックします。

ステップ 4 下部ペインの右側で、[Copy & Edit]をクリックします。

CiscoDNACenterでは、「Clone ofDiscovery_Job」という名前でディスカバリジョブのコピーが作成されま
す。

ステップ 5 （任意）ディスカバリジョブの名前を変更するには、[Discovery Name]フィールドのデフォルト名を新し
い名前に置き換えます。

ステップ 6 新しいディスカバリジョブのパラメータを定義または更新します。

ディスカバリジョブの削除

アクティブまたは非アクティブに関係なく、検出ジョブを削除できます。

ステップ 1 メニューアイコン（ ）をクリックして、[Tools] > [Discovery]。

ステップ 2 [Discovery]ウィンドウで、[All discoveries page from previous release]をクリックします。

ステップ 3 左側の [Discoveries]ペインで、削除するディスカバリジョブをクリックします。

ステップ 4 下部ペインの右側で、[Delete]をクリックします。

ステップ 5 [OK]をクリックして確定します。

ディスカバリジョブ情報の表示

使用された設定やクレデンシャルなどの、ディスカバリジョブに関する情報を表示できます。

実行された各ディスカバリジョブに関する履歴情報（検出されたデバイスや検出に失敗したデ

バイスに関する情報など）も表示できます。

始める前に

少なくとも 1つのディスカバリジョブを実行します。

ステップ 1 メニューアイコン（ ）をクリックして、[Tools] > [Discovery]。
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ステップ 2 [Discovery]ウィンドウで、[All discoveries page from previous release]をクリックします。

ステップ 3 左の [Discoveries]ペインで、ディスカバリジョブを選択します。もしくは、[Search]機能を使用して、デ
バイス IPアドレスまたは名前によって、ディスカバリジョブを検索できます。

ステップ 4 詳細については、次の領域のひとつの隣にある下矢印をクリックします。

• [Discovery Details]：ディスカバリジョブを実行するために使用されたパラメータが表示されます。パ
ラメータには、CDPまたは LLDPレベル、IPアドレス範囲、およびプロトコルの順序などの属性が含
まれます。

• [Credentials]：使用されたログイン情報の名前が提供されます。

• [History]：開始された時間およびデバイスが検出されたかどうかを含め、実行された各ディスカバリ
ジョブがリストされます。

組み込みワイヤレスコントローラを正常に検出するには、NETCONFポートを設定する必要がありま
す。NETCONFポートが設定されていない場合、ワイヤレスデータは収集されません。

[Filter]機能を使用して、IPアドレスあるいは ICMP、CLI、HTTPS、NETCOMF値の任意の組み合わせ
によってデバイスを表示できます。

ネットワーク階層の設計
ネットワークの地理的な場所を表すネットワーク階層を作成できます。ネットワーク階層に

は、ビルディングやエリアなどが存在するサイトを含めることができます。

ネットワーク階層の概要

ネットワークの地理的な場所を表すネットワーク階層を作成できます。この階層構造により、

デザインの設定や構成を特定の階層要素に簡単に適用できます。たとえば、デザインの設定を

エリア全体に適用したり、床のみに適用したりすることができます。

デザインの設定を適用する場所を後で識別できるように、階層要素に名前を付けることができ

ます。

作成できる階層要素には、その階層要素をどの要素に配置できるか、またどの要素をその階層

要素に配置できるかを指定するルールがあります。

• [Global]：他のすべての階層要素がその中に存在するデフォルトの要素。[Global]の直下に
配置することが可能な要素は、エリアおよびサイトのみです。

• [Areas]と [Sites]：エリア（Area）とサイト（Site）は、[Global]または他のエリアやサイト
に存在します。エリアとサイトには物理アドレスがありません。最大の要素として、地理

的地域を識別します。エリアとサイトにより、エリアおよびサイトのグループ化が可能に

なります。
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• [Buildings]：建物（Building）は、エリアまたはサイトに存在します。建物を作成する場
合、物理アドレスまたは緯度と経度の座標を指定する必要があります。建物にエリアを含

めることはできません。ただし、フロアを含めることはできます。

• [Floors]：フロア（Floor）は建物に存在します。壁や窓など、建物のさまざまなコンポー
ネントを含むマップの有無にかかわらず、建物にフロアを追加できます。フロアマップを

使用する場合は、手動で作成するか、DXF、DWG、JPG、GIF、PNG、またはPDFを含む
ファイルタイプのファイルからインポートできます。次に、ワイヤレスデバイスをフロア

マップに配置して、ワイヤレスネットワークのカバレッジを視覚化できます。

プロビジョニングされていないデバイスのサイト階層は、フロアマップ上の APの場所を
維持したまま変更できます。ただし、既存のフロアを別の建物に移動できないことに注意

してください。

開始するには、次のいずれかの方法を使用してネットワーク階層を構築します。

•新しいネットワーク階層を作成する。詳細については、「新しいネットワーク階層の設計
（33ページ）」を参照してください。

• Cisco Prime Infrastructureまたは Ekahau Proから既存のネットワーク階層をインポートす
る。詳細については、Cisco DNA Centerユーザガイドのを参照してください。

新しいネットワーク階層の設計

[Design]領域では、ネットワーク全体のデバイスに適用可能な物理トポロジ、ネットワーク設
定、デバイスのタイプやプロファイルなど、ネットワークの構造とフレームワークを作成しま

す。既存のインフラストラクチャがない場合は、設計ワークフローを使用します。既存のイン

フラストラクチャがある場合は、ディスカバリ機能を使用します。詳細については、「検出の

概要（4ページ）」を参照してください。

これらのタスクは、[Design]領域で実行します。

ステップ 1 ネットワーク階層を作成します。

ステップ 2 グローバルネットワーク設定を定義します。

ステップ 3 ネットワークプロファイルを定義します。

既存の Ciscoネットワーク階層の使用
Cisco Prime Infrastructureに既存のネットワーク階層がある場合は、エクスポートしてからCisco
DNA Centerにインポートすることで、新しいネットワーク階層の作成に費やす時間と労力を
削減できます。

次の情報を使用して、ネットワーク階層を再作成できます。
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•サイト階層：既存のサイト階層を CSVファイル形式でダウンロードします。CSVファイ
ルには、サイト名、親階層、フロア数、場所、サイトアドレスなどの詳細が含まれていま

す。

•マップアーカイブ：マップ情報をTARファイル形式のマップアーカイブとしてダウンロー
ドします。マップアーカイブファイルには、日時、フロアの数、APなどのデータが格納
されます。ダウンロードするものに応じて、マップアーカイブには、フロアの寸法（長

さ、幅、高さ）や、フロアマップに配置されている APおよびオーバーレイオブジェクト
に関する詳細などのマップ情報も含めることができます。各フロアに適用されている RF
減衰モデルなどのキャリブレーション情報をダウンロードすることもできます。

マップアーカイブの基礎をグローバル階層に置くか、次のように単一のサイト、建物、ま

たはフロアの階層に置くかを選択できます。

• [Site]：選択したサイトとそのすべてのサブサイト、建物、およびフロアがエクスポー
トされます。

• [Building]：選択した建物とそのすべてのフロアがエクスポートされます。

• [Floor]：選択したフロアがエクスポートされます。

Cisco DNA Centerは米国の連邦情報処理標準（FIPS）をサポート
しています。FIPSは、Cisco DNA Centerイメージのインストール
時に有効にできるオプションのモードです。デフォルトでは、

FIPSモードはディセーブルです。

（注）

FIPSモードは、マップアーカイブのエクスポートとインポートに次の影響を与えます。

FIPSモードが有効な場合：

•エクスポートされるマップアーカイブは暗号化されません。

•暗号化されていないマップアーカイブのみをインポートできます。

FIPSモードが無効な場合：

•エクスポートされるマップアーカイブは暗号化されます。

•暗号化されたマップアーカイブと暗号化されていないマップアーカイブの両方をイン
ポートできます。

詳細については、Cisco DNA Centerユーザガイドを参照してください。

マップ内で使用するイメージファイルに関するガイドライン

マップイメージファイルを使用するには、次のガイドラインに従ってください。
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•マップのイメージファイルを .jpg、.gif、.png、.pdf、.dxf、.dwgなどの形式で保存できるグ
ラフィカルアプリケーションを使用します。

•マップのイメージファイルのサイズはさまざまです。Cisco DNA Centerは元のイメージを
フル解像度でデータベースにインポートしますが、表示中は、ワークスペースに合わせて

サイズが自動的に変更されます。

•インポートする前に、サイトの縦と横の寸法をフィートまたはメートル単位で取得してく
ださい。これにより、マップインポート時にこれらの寸法を指定できます。

•回転メタデータを持つフロアマップイメージは、CMXや Cisco DNA Spacesに同期したと
きに正しく表示されないことがあるため、使用しないようにします。フロアマップイメー

ジはCiscoDNACenterでサポートされているフォーマットだとしても、特定のツールがメ
タデータを追加する方法によって、異なる方法でレンダリングされる可能性があります。

たとえば、回転メタデータを含むイメージファイルを3つの異なるアプリケーションで開
くと、2つのアプリケーションでは水平にレンダリングされ、もう一方のアプリケーショ
ンでは垂直にレンダリングされる場合があります。

ネットワーク階層のサイトの作成

Cisco DNA Centerでは、物理サイトを簡単に定義し、それらのサイトの共有リソースを特定す
ることができます。[Design]エリアは、直観的な操作のために階層型になっており、デバイス
をプロビジョニングするときに同じリソースを複数の場所で再定義する必要がありません。デ

フォルトでは、グローバルと呼ばれる1つのサイトがあります。ネットワーク階層には、複数
のサイト、ビルディング、およびエリアを追加できます。プロビジョニング機能を使用する前

に、少なくとも 1つのサイトを作成する必要があります。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

世界地図が右側のペインに表示されます。

ステップ 2 マップツールバーから、[+ Add Site] > [Add Area]をクリックします。

または、左側のペインで親サイトの横にある省略記号 にカーソルを合わせ、[Add Area]を選択するこ
ともできます。

ステップ 3 [Area Name]フィールドに、サイト名を入力します。

ステップ 4 [Parent]ドロップダウンリストから、親ノードを選択します。[Global]がデフォルトの親ノードです。

ステップ 5 [Add]をクリックします。

左側ペインの親ノードにサイトが作成されます。
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建物の追加

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 [Network Hierarchy]ウィンドウで、[+Add Site] > [Add Building]をクリックします。

または、左側のペインで親サイトの横にある省略記号 にカーソルを合わせ、[AddBuilding]を選択する
こともできます。

ステップ 3 [Add Building]ダイアログボックスで建物の詳細を追加します。

a) [Building Name]フィールドに建物の名前を入力します。
b) [Parent]ドロップダウンリストから、親ノードを選択します。[Global]がデフォルトの親ノードです。
c) [Address]フィールドにアドレスを入力します。

また、マップをクリックしてアドレスを入力することもできます。アドレスを追加すると、[Longitude]
および [Latitude]の座標フィールドが自動的に設定されます。経度と緯度の座標を手動で変更して、ア
ドレスを変更できます。

ステップ 4 [Add]をクリックします。

左側ペインの親サイトに建物が作成され、表示されます。

建物への基本フロアの追加

ビルディングを追加したら、それにフロアを追加できます。フロアマップのない基本フロアを

追加することも、フロアを追加すると同時にフロアマップを含めることもできます。

建物に基本フロアを追加するには、次の手順を使用します。

CAD、非 CAD、または Ekahauファイルのフロアマップを含むフロアを追加するには、Cisco
DNA Centerユーザガイドを参照してください。:

ステップ 1 メニューアイコン（ ）をクリックして、 [Design] > [Network Hierarchy]。

ステップ 2 左側のペインで、建物の横にある省略記号 の上にカーソルを置き、[Add Floor]を選択します。

ステップ 3 [Floor Name]フィールドにフロアの名前を入力します。

ステップ 4 [Type（RF Model）]ドロップダウンリストから、フロアに適用する RFモデルを選択します。

RFモデルは、フロアの特性に基づいて RFを計算する方法を決定します。（注）

ステップ 5 [Add]をクリックします。
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ネットワーク階層の管理

Cisco DNA Centerへのサイト階層のインポート

Cisco Prime Infrastructureから CSVファイルとしてエクスポートしたサイト階層をインポート
できます。サイト階層のエクスポートについては、Cisco DNA Centerユーザガイドを参照して
ください。

始める前に

• Cisco DNACenterインベントリにシスコワイヤレスコントローラおよびAPがあることを
確認します。ない場合は、[Discovery]機能を使用して検出します。

•フロアマップ上に APを追加して配置します。

• Cisco Prime Infrastructureにあるサイトを Cisco DNA Centerで手動作成した場合は、イン
ポートする前にそれらのサイトを Cisco DNA Centerから削除する必要があります。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 マップツールバーから [Import]をクリックし、[Import Sites]を選択します。

ステップ 3 ダイアログボックスで、次のいずれかのオプションボタンをクリックします。

• [Merge with Existing Sites]：ダウンロードしたサイト情報を既存のサイト情報と結合します。

• [Overwrite Existing Sites]：Cisco DNA Centerに同じサイトがすでに存在する場合、既存のサイト情報は
ダウンロードしたサイト情報で上書きされます。

ステップ 4 ダイアログボックスで、CSVファイルをダウンロードエリアにドラッグアンドドロップします。または、
[Choose a file]をクリックして CSVファイルの場所に移動し、[Upload]をクリックすることもできます。

CSVファイルがない場合は、[Download Template]をクリックして、CSVファイルをダウンロー
ドし、編集してからアップロードできます。

（注）

Cisco Prime Infrastructureからのマップアーカイブのエクスポート

CiscoPrime Infrastructureからマップアーカイブファイルをエクスポートし、それらをCiscoDNA
Centerにインポートできます。マップアーカイブには、フロア寸法などのマップ情報と Cisco
Prime Infrastructureの各フロアに適用されている無線周波数（RF）減衰モデルなどのキャリブ
レーション情報が含まれています。

ステップ 1 Cisco Prime Infrastructure GUIから、[Maps] > [Wireless Maps] > [Site Maps (New)]の順に選択します。

ステップ 2 [エクスポート（Export）]ドロップダウンリストから [マップアーカイブ（Map Archive）]を選択しま
す。
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[Export Map Archive]ウィンドウが開き、デフォルトで [Select Sites]ウィンドウが開きます。

ステップ 3 エクスポートする特定のサイト、キャンパス、ビルディング、またはフロアのチェックボックスをオンに
します。すべてのマップをエクスポートする場合は、[Select All]チェックボックスをオンにします。

ステップ 4 次のオプションの少なくとも 1つを選択します。

• [Map Information]：[On]ボタンをクリックして、フロアの寸法（長さ、幅、高さ）と、フロアマップに
配置された APおよびオーバーレイオブジェクトに関する詳細をエクスポートします。

• [Calibration Information]：[On]ボタンをクリックして、各フロアに適用されている RF減衰モデルをエ
クスポートします。既存のキャリブレーションデータを Cisco Prime Infrastructureからエクスポートす
ることをお勧めします。それ以外の場合は、キャリブレーションの詳細を手動で再入力する必要があ

ります。

キャリブレーション情報を含めることを選択した場合は、次のように、選択したマップの情報を含め

るか、すべての情報を含めるかを指定する必要もあります。

• [Calibration Information for selected maps]：選択したサイトマップのキャリブレーション情報がエク
スポートされます。

• [All Calibration Information]：選択したマップに加えて、システムで使用可能なその他のキャリブ
レーション情報もエクスポートされます。

ステップ 5 ［マップアーカイブを生成（Generate Map Archive）］をクリックします。

次のメッセージは、操作の進行状況を示しています。

Exporting data is in progress

TARファイルが作成され、ローカルマシンに保存されます。

ステップ 6 [Done]をクリックします。

ネットワーク階層の検索

ネットワーク階層を検索し、サイト、ビルディング、またはエリアをすばやく見つけることが

できます。これは、多くのサイトやエリア、ビルディングを追加した後に特に役立ちます。

ステップ 1 階層を検索するには、左側のペインの [Search Hierarchy]検索フィールドで、検索するサイト、建物、フロ
ア名の名称の一部または正式名称のどちらかを入力します。

階層は、検索フィールドに入力したテキストに基づきフィルタリングされます。

ステップ 2 [Site Name]と [Site Type]のフィルタ基準で階層を検索するには、[Search Hierarchy]検索フィールドのフィ
ルタアイコンをクリックし、次の手順を実行します。

1. [Site Name]名前フィールドに、検索するサイトの名前を入力します。

2. 検索結果にすべての建物の住所を含めるには、[IncludeAddress for all Building]チェックボックスをオン
にします。

アシュアランスを使用するための Cisco DNA Centerの設定
38

アシュアランスを使用するための Cisco DNA Centerの設定

ネットワーク階層の検索



3. [Site Type]領域で、フィルタ条件に含める [Area]、[Outdoor Area]、[Building]、または [Floor]の横にあ
るチェックボックスをオンにします。

4. [Search]をクリックします。

フィルタ基準に基づいて、階層がフィルタリングされます。

5. 左側のペインの検索条件を除外するには、それぞれの条件の横にある Xマークをクリックします。

サイトの編集

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 左側のペインで、サイトの横にある省略記号 にカーソルを合わせて、[Edit Area]を選択します。

ステップ 3 [Edit Area]ダイアログボックスで、必要な編集を行います。

ステップ 4 [Update]をクリックして変更を保存します。

サイトの削除

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 左側のペインで、サイトの横にある省略記号 にカーソルを合わせて、[Delete Area]を選択します。

ステップ 3 ダイアログボックスで [OK]をクリックして、削除を確定します。

ビルディングの編集

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 左側のペインで、ビルディングの横にある省略記号 にカーソルを合わせて、[Edit Building]を選択しま
す。

ステップ 3 [Edit Building]ダイアログボックスで、必要な編集を行います。

ステップ 4 [Update]をクリックして変更を保存します。

ビルディングの削除

ビルディングを削除すると、そのコンテナマップもすべて削除されます。削除されたマップ内

の APは、未割り当ての状態に移行します。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。
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ステップ 2 左側のペインで、ビルディングの横にある省略記号 にカーソルを合わせて、[Delete Building]を選択し
ます。

ステップ 3 ダイアログボックスで [OK]をクリックして、削除を確定します。

フロアの編集

フロアを追加したら、フロア上にある障害物、エリア、および APが含まれるようにフロア
マップを編集できます。

ステップ 1 [Menu]アイコン（ ）をクリックして、[Design] > [Network Hierarchy]の順に選択します。

ステップ 2 左側のペインで、そのフロアの横にある省略記号 にカーソルを合わせて、[Edit Floor]を選択します。

ステップ 3 [Edit Floor]ポップアップで、必要な変更を行います。

ステップ 4 [Update]をクリックして変更を保存します。

2Dでのフロアマップのモニタリング

[Floor View]ナビゲーションウィンドウでは、次のような複数のマップ機能にアクセスできま
す。

•フロアマップウィンドウの右上隅にある [Find]機能を使用して、AP、センサー、クライ
アントなど特定のフロア要素を検索します。検索基準に一致する要素は、右側のペインで

テーブルとともにフロアマップに表示されます。マウスをテーブルの上に置くと、フロア

マップ上の検索要素が接続線で示されます。

•フロアマップウィンドウの右上隅にある アイコンをクリックして、次の作業を行いま

す。

•フロアプランを PDFとしてエクスポートします。

•フロアマップで距離を測定します。

•スケールを設定してフロア面積を変更します。

•フロアマップウィンドウの右下隅にある アイコンをクリックして、場所をズームイン

します。ズームレベルは画像の解像度によって異なります。高解像度画像では、より高い

ズームレベルを使用できます。各ズームレベルはさまざまなスケールで表示される各種

スタイルマップで構成されていて、対応する詳細が表示されます。マップの中にはスケー

ルを小さくしても大きくしても同じ状態のマップもあります。

• アイコンをクリックすると、広範囲のマップが表示されます。

• アイコンをクリックすると、マップアイコンの凡例が表示されます。
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2Dマップでのフロアマップ要素とオーバーレイの構成

2Dマップを表示しているときに、マップツールバーの [Add/Edit]をクリックして編集モード
に入ります。編集モードでは、次のことができます。

•次のデバイスを追加、配置、および削除します。

•アクセスポイント（AP）と計画されたアクセスポイント（PAP）

• Sensor

•次のオーバーレイオブジェクトを追加、編集、および削除します。

•カバレッジエリア

•ロケーションリージョン

•壁

•棚ユニット

•マーカー

• \[GPS Markers\]

•ポイントの位置合わせ

フロアマップでの APの操作

Cisco DNA Center Cisco DNA Centerによって、カバレッジエリアの無線周波数（RF）信号の相
対強度を表示する全体マップのヒートマップが計算されます。2Dワイヤレスマップの場合、
このヒートマップは、石壁や金属の物体など、ビルディングのさまざまな素材の減衰は考慮さ

れておらず、RF信号が障害物に跳ね返る影響も表示されないため、実際のRF信号強度の近似
値に過ぎません。

フロアマップに APを配置する際は、次の注意事項を考慮してください。

•部屋や建物の屋外の近くにデバイスが置かれるように、カバレッジ領域の境界に沿って
APを設置します。このようなカバレッジ領域の中心に設置されたAPからは、場合によっ
ては他の全 APから等距離に見えてしまうデバイスに関しても有益なデータが得られま
す。

• AP全体の密度を高め、APをカバレッジエリアの周辺部に近づけることにより、位置精
度を向上させることができます。

•細長いカバレッジ領域では、直線的に APを配置しないようにします。各 APでデバイス
ロケーションのスナップショットが他と異なるように、それらを交互にずらします。

•設計では高帯域幅アプリケーションにも十分に対応できる AP密度が提供されますが、位
置に関しては、単一デバイスの各 APビューが似ているという弱点があります。そのこと
が位置の判別を困難にしています。APをカバレッジ領域の周辺に移動して、それらを交
互にずらします。それぞれにおいてデバイスの見え方が明確に異なる可能性が高くなり、

結果としてより位置精度が高まります。
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•フロアマップでのヒートマップの表示を最適化するには、APの高さを約 10フィート（3
m）以下に設定します。

APの追加、配置、編集、および削除

Cisco DNA Center Cisco DNA Centerによって、カバレッジエリアの無線周波数（RF）信号の相
対強度を表示する全体マップのヒートマップが計算されます。2Dワイヤレスマップの場合、
このヒートマップは実際の RF信号強度の近似値にすぎません。信号に影響を与える RF信号
の反射やその他の影響が考慮されていないためです。

始める前に

インベントリにシスコの APがあることを確認してください。デバイスがない場合は、ディス
カバリ機能を使用して APを検出します。「検出の概要」を参照してください。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 左側のペインで、サイトをクリックしてからビル名をクリックし、最後に関心のあるフロアをクリックし
ます。

ステップ 3 マップツールバーで [AP]トグルボタンが有効になっていることを確認します。

ステップ 4 マップツールバーから、[Add/Edit]をクリックします。

ステップ 5 マップから、APを追加、編集、配置、再配置、および削除できます。詳細については、次の表を参照して
ください。

手順アクション

1. マップの左側のペインで、[Add APs]をクリックします。

2. [Add APs]スライドインペインでは、次のいずれかの操作を実
行できます。

•単一のAPを追加するには：追加するAPの横にある [Add]
をクリックします。

•複数のAPを追加するには：追加するAPの横にあるチェッ
クボックスをオンにして、[Add Selected]をクリックしま
す。

新しく追加されたAPは、マップの左ペインの [Unpositioned]
カテゴリに表示されます。

3. [Save]をクリックします。

APの追加
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手順アクション

1. マップの左ペインの [Unpositioned]カテゴリから、APをクリッ
クします。

2. APを配置するフロアマップ上の場所をクリックします。

3. [Save]をクリックします。

APの配置

1. マップで、APをクリックして選択します。

2. APを新しい位置にドラッグアンドドロップします。

3. [Save]をクリックします。

APの位置変更

1. マップで、APをクリックします。

2. [Edit AP]スライドインペインから、必要に応じて AP設定を構
成します。

3. [Save]をクリックします。

APの編集

1. 次のいずれかの方法を使用して、APを選択します。

•最初のデバイスをクリックし、Shiftキーを押しながら残り
のデバイスをクリックします。

•マップナビゲーションツールバーで、[Select by rectangle]
をクリックします。次に、マップの領域をクリックし、強

調表示された長方形をドラッグして、連続した領域内の

APを選択します。長方形内で強調表示されているすべて
の APが選択されています。

2. [Edit AP]スライドインペインから、必要に応じて AP設定を構
成します。

3. [Apply]をクリックします。

4. [Save]をクリックします。

複数の APの編集

複数の APを編集する場
合、属性値は、値が同じ

であれば表示されます。

そうでない場合は空白で

す。アンテナの値は、選

択した APのモデル番号
と無線（無線の数と動作

帯域）が同じである場合

にのみ編集できます。計

画された APのモデル番
号は変更できますが、追

加された APは変更でき
ません。

（注）

1. APまたは計画された APをクリックします。

2. マップの左側のペインで、[Remove APs]をクリックします。

3. [Save]をクリックします。

APの削除
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APのクイックビュー

フロアマップ上の APアイコンにカーソルを合わせると、APの詳細、Rxネイバーの情報、ク
ライアントの情報、およびデバイス 360の情報が表示されます。

• [Info]をクリックすると、次の APの詳細が表示されます。

• [Associated]：APが関連付けられているかどうかを示します。

• [Name]：AP名。

• [MAC Address]：APのMACアドレス。

• [Model]：APモデル番号。

• [Admin/Mode]：APモードの管理ステータス。

• [Type]：無線タイプ。

• [OP/Admin]：動作ステータスおよび APモード。

• [Channel]：APのチャネル番号。

• [Antenna]：アンテナ名。

• [Azimuth]：アンテナの方向。

• [Rx Neighbors]ラジオボタンをオンにすると、マップ上に選択したAPに隣接するRxネイ
バーが接続回線とともに表示されます。また、フロアマップにはAPが関連付けられてい
るかどうかも AP名とともに表示されます。

• [Device 360]をクリックすると、特定のネットワーク要素（ルータ、スイッチ、AP、また
はシスコワイヤレスコントローラ）の 360度ビューが表示されます。

デバイス 360を開くには、アシュアランスアプリケーションをイ
ンストールしている必要があります。

（注）

マップへのセンサーの追加

インベントリにCiscoAP1800Sセンサーがあることを確認します。CiscoAironet 1800sアクティ
ブセンサーをインベントリで表示するには、プラグアンドプレイを使用してプロビジョニング

する必要があります。

（注）

センサーデバイスは AP 1800sセンサー専用です。Cisco Aironet 1800sアクティブセンサーは、
PnPを使用してブートストラップされます。アシュアランスサーバーに到達可能かどうかの詳
細情報を取得してからアシュアランスサーバーと直接通信します。センサーテストに関する

情報を含む詳細については、『Cisco DNAアシュアランス User Guide』を参照してください。
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ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 フロアを左側の階層ツリーで、次を選択します。します。

ステップ 3 マップツールバーから、[2D] > [Add/Edit] > [Sensors]をクリックします。

ステップ 4 [Add Sensors]スライドインペインから、追加するセンサーのチェックボックスをオンにします。またはセ
ンサー行の横にある [Add]をクリックします。

[Filter]フィールドを使用して、特定のセンサーを検索できます。センサーの名前、MACアドレ
ス、モデルを使用して検索します。この検索では、大文字と小文字は区別されません。結果が

テーブルに表示されます。[Add]をクリックして、フロア領域に1つ以上のセンサーを追加しま
す。

（注）

新しく追加されたセンサーは、編集モードのマップの左ペインの [Unpositioned]カテゴリに表示されます。

ステップ 5 完了したら、[Save]をクリックします。

カバレッジエリアの追加、編集、および削除

既定では、フロア領域やビルディングマップの一部として定義されている外部エリアが無線カ

バレッジエリアと見なされます。

長方形以外の建物がある場合、またはフロア内で長方形以外の領域をマークする場合には、

マップ描画ツールを使用してカバレッジエリアまたは多角形の領域を作成できます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 フロアを左側の階層ツリーで、次を選択します。します。

ステップ 3 マップツールバーから、[2D] > [Add/Edit] > [Overlays] > [Coverage Areas]をクリックします。

ステップ 4 カバレッジエリアを追加するには、次の手順を実行します。

a) [Coverage Area]ダイアログボックスで、フィールドにカバレッジエリアの名前を入力します。
b) [Add Coverage]をクリックします。
c) マップをクリックしてポイントを作成し、描画ツールを開始します。
d) 引き続きポイントを作成して、カバレッジエリアの形状を定義します。

カバレッジエリアの形状には、少なくとも 3つのポイントが必要です。ポイントをクリッ
クしてドラッグすると、カバレッジエリアの形状を定義し直すことができます。

（注）

e) ダブルクリックして描画ツールを終了し、カバレッジエリアの形状を確定します。
f) マップツールバーの [Save]をクリックします。

ステップ 5 カバレッジエリアを編集するには、次の手順を実行します。

a) マップツールバーから、[Add/Edit] > [Coverage Areas]をクリックします。

b) カバレッジエリアの形状を定義し直すには、ポイントをクリックしてドラッグします。
c) カバレッジエリアの名前を編集するには、カバレッジエリアを右クリックして [Edit]を選択します。
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d) 完了したら、マップツールバーの [Save]をクリックします。

ステップ 6 カバレッジエリアを削除するには、次の手順を実行します。

a) マップツールバーから、[Add/Edit] > [Coverage Areas]をクリックします。

b) カバレッジエリアを右クリックし、[Delete]を選択します。
c) カバレッジエリアが削除されたら、マップツールバーから [Save]をクリックします。

障害物の作成

アクセスポイントのRF予測ヒートマップを計算する際に考慮するための障害を作成すること
ができます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 左ペインで、フロアを選択します。

ステップ 3 中央のペインのフロアプランの上にある [Edit]をクリックします。

ステップ 4 [Obstacles]の横にある [Overlays]パネルで、[Add]をクリックします。

ステップ 5 [Obstacle Creation]ダイアログボックスで、[Obstacle Type]ドロップダウンリストから障害のタイプを選
択します。作成可能な障害のタイプは、[ThickWall]、[LightWall]、[HeavyDoor]、[LightDoor]、[Cubicle]、
および [Glass]です。
選択した障害のタイプの予測信号損失が自動的に取り込まれます。信号損失は、これらのオブジェクト

の周辺の RF信号強度を計算するために使用されます。

ステップ 6 [Add Obstacle]をクリックします。

ステップ 7 障害物を作成する領域に描画ツールを移動します。

ステップ 8 描画ツールをクリックして、描線を開始および停止します。

ステップ 9 エリアの輪郭を描画したら、そのエリアをダブルクリックして強調表示します。

ステップ 10 [Obstacle Creation]ウィンドウで [Done]をクリックします。

ステップ 11 [Save]をクリックして、障害をフロアマップに保存します。

ステップ 12 障害を編集するには、[Obstacles]の隣にある [Overlays]パネルで、[Edit]をクリックします。

すべての使用可能な障害物がマップ上で強調表示されます。

ステップ 13 変更が完了したら、[Save]をクリックします。

ステップ 14 障害を削除するには、[Obstacles]の隣にある [Overlays]パネルで、[Delete]をクリックします。

すべての使用可能な障害物がマップ上で強調表示されます。

ステップ 15 障害にマウスカーソルを合わせ、クリックして削除します。

ステップ 16 [Save]をクリックします。
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ロケーションリージョンの追加、編集、および削除

包含領域および除外領域を作成して、フロア上のロケーション計算の精度をさらに高めること

ができます。計算に含める領域（包含領域）と計算に含めない領域（除外領域）を定義できま

す。たとえば、ビルディング内のアトリウムや階段の吹き抜けなどの領域を除外して、作業領

域（小個室、研究室、製造現場など）を含めることができます。

マップ上での包含および除外領域を定義するには、次のガイドラインを使用します。

•包含領域と除外領域は多角形領域で表され、最低 3点で構成される必要があります。

•フロア上の包含リージョンを1つだけ定義できます。デフォルトでは、各フロア領域が作
成されるときに、各フロア領域に対して包含領域が定義されます。包含領域は、水色の実

線で示され、通常はフロア領域全体の輪郭を描きます。

• 1つのフロア領域に複数の除外領域を定義することができます。

マップ上での包含および除外領域の定義

マップ上での包含および除外領域を定義するには、次のガイドラインを使用します。

•包含領域と除外領域は多角形領域で表され、最低 3点で構成される必要があります。

•フロア上の包含リージョンを1つだけ定義できます。デフォルトでは、各フロア領域が作
成されるときに、各フロア領域に対して包含領域が定義されます。包含領域は、水色の実

線で示され、通常はフロア領域全体の輪郭を描きます。

• 1つのフロア領域に複数の除外領域を定義することができます。

包含リージョンの追加、編集、および削除

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 フロアを左側の階層ツリーで、次を選択します。します。

ステップ 3 マップツールバーから、[2D] > [Add/Edit] > [Overlays] > [Location Regions]をクリックします。

ステップ 4 マップの左側のペインから、[Inclusion]アイコンをクリックします。

ステップ 5 包含リージョンを作成するには、描画ツールを使用します。

a) マップをクリックして、包含リージョンを開始するポイントを作成します。
b) カーソルを次のポイントに移動して、もう一度クリックします。
c) 引き続きポイントを作成して、包含リージョンの形状を定義します。
d) 形状を完成させるには、マップをダブルクリックします。

または、マップの左側のペインから、[Inclusion]アイコンをクリックします。

e) 描画ツールを終了するには、マップをもう一度ダブルクリックします。

ステップ 6 包含リージョンの場所を編集するには、その形状を新しい場所にドラッグアンドドロップします。

ステップ 7 包含リージョンを削除するには、形状を右クリックして [Delete]を選択します。
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ステップ 8 マップツールバーの [Save]をクリックします。

除外リージョンの追加、編集、および削除

フロアの計算の精度を高めるため、計算から除外するリージョン（除外リージョン）を定義で

きます。たとえば、建物内のアトリウムや階段の吹き抜けなどのリージョンを除外できます。

原則として、除外リージョンは包含リージョンの境界内に定義されます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 フロアを左側の階層ツリーで、次を選択します。します。

ステップ 3 マップツールバーから、[2D] > [Add/Edit] > [Overlays] > [Location Regions]をクリックします。

ステップ 4 マップの左側のペインから、[Exclusion]アイコンをクリックします。

ステップ 5 除外リージョンを作成するには、描画ツールを使用します。

a) マップをクリックして、除外リージョンを開始するポイントを作成します。
b) カーソルを次のポイントに移動して、もう一度クリックします。
c) 引き続きポイントを作成して、除外リージョンの形状を定義します。
d) 形状を完成させるには、マップをダブルクリックします。

または、マップの左側のペインから、[Exclusion]アイコンをクリックします。

e) 描画ツールを終了するには、マップをもう一度ダブルクリックします。

ステップ 6 除外リージョンの場所を編集するには、その形状を新しい場所にドラッグアンドドロップします。

ステップ 7 除外リージョンを削除するには、形状を右クリックして [Delete]を選択します。

ステップ 8 マップツールバーの [Save]をクリックします。

ロケーションリージョンの編集

ステップ 1 [Overlays]パネルで、[Location Regions]の横にある [Edit]をクリックします。
使用可能なロケーションリージョンがマップ上で強調表示されます。

ステップ 2 必要な変更を行って、[Save]をクリックします。

ロケーションリージョンの削除

ステップ 1 [Overlays]パネルで、[Location Regions]の横にある [Delete]をクリックします。
使用可能なロケーションリージョンがマップ上で強調表示されます。

ステップ 2 削除する領域の上にマウスのカーソルを合わせ、[Delete]をクリックします。

ステップ 3 [Save]をクリックします。
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レールの作成

フロア上にコンベヤベルトを表すレールラインを定義できます。また、レール領域の周囲にス

ナップ幅とも呼ばれる、ロケーション計算をさらにサポートする領域を定義できます。この領

域は、クライアントが表示されると予測される領域を表します。スナップ幅の領域内に配置さ

れたクライアントは、レールライン上に表示されるか（多数）、スナップ幅領域の外側に表示

されます（少数）。

スナップ幅領域は、フィートまたはメートル（ユーザー定義）単位で定義され、レールの片側

（東および西、または北および南）からモニターされる距離を表します。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 左ペインで、フロアを選択します。

ステップ 3 中央のペインのフロアプランの上にある [Edit]をクリックします。

ステップ 4 [Rails]の横にある [Overlays]パネルで、[Add]をクリックします。

ステップ 5 レールのスナップ幅（フィートまたはメートル）を入力し、[Add Rail]をクリックします。

描画アイコンが表示されます。

ステップ 6 レールラインの開始ポイントで描画アイコンをクリックします。ラインの描画を停止するときやライン

の方向を変える際は、再びクリックします。

ステップ 7 フロアマップ上にレールラインを描画したら、描画アイコンを 2回クリックします。レールラインは
マップ上に表示され、片側は定義されたスナップ幅リージョンに接します。

ステップ 8 [Save]をクリックします。

ステップ 9 [Overlays]パネルで、[Rails]の横にある [Edit]をクリックします。

使用可能なレールがマップ上で強調表示されます。

ステップ 10 変更を加えて、[Save]をクリックします。

ステップ 11 [Overlays]パネルで、[Rails]の横にある [Delete]をクリックします。

使用可能なすべてのレールラインがマップ上で強調表示されます。

ステップ 12 削除するレールラインの上にマウスのカーソルを合わせ、[Delete]をクリックします。

ステップ 13 [Save]をクリックします。

マーカーの追加、編集、および削除

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

ステップ 2 フロアを左側の階層ツリーで、次を選択します。します。

ステップ 3 マップツールバーから、[2D] > [Add/Edit] > [Overlays] > [Markers]をクリックします。

ステップ 4 マップの左側のペインから、[Markers]アイコンをクリックします。

ステップ 5 [Place Markers]ダイアログボックスで、マーカーの名前を入力し、[Add Marker]をクリックします。
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ステップ 6 マーカーを配置するには、マーカーを配置するマップをクリックします。

ステップ 7 マーカーを移動するには、マーカーが青色に変わるまでカーソルを合わせます。次に、マーカーを新し

い場所にドラッグアンドドロップします。

ステップ 8 マーカーを編集するには、マーカーを右クリックして [Edit]を選択します。

ステップ 9 マーカーを削除するには、マーカーを右クリックして [Delete]を選択します。

ステップ 10 マップツールバーの [Save]をクリックします。

フロアビューオプション

中央のペインのフロアプランの上にある [View Options]をクリックします。フロアマップと
[Access Points]、[Sensor]、[Overlay Objects]、[Map Properties]、および [Global Map Properties]の
各パネルが右側のペインに表示されます。

フロアマップの外観を変更するには、さまざまなパラメータを選択または選択解除します。た

とえば、フロアマップ上のアクセスポイント情報だけを表示する場合は、[AccessPoint]チェッ
クボックスをオンにします。各パネルを展開して、各フロア要素で使用可能なさまざまな設定

を構成できます。

アクセスポイントの表示オプション

アクセスポイントをマップ上に表示するには、[Access Points]の横にある [On/Off]ボタンをク
リックします。[Access Points]パネルを展開して、次の設定を行います。

• [Display Label]：ドロップダウンリストから、APに関してフロアマップに表示するテキス
トラベルを選択します。使用可能な表示ラベルは次のとおりです。

• [None]：選択したアクセスポイントに関してラベルが表示されません。

• [Name]：AP名。

• [AP MAC Address]：APのMACアドレス。

• [Controller IP]：アクセスポイントが接続されているシスコワイヤレスコントローラ
の IPアドレス。

• [Radio MAC Address]：無線MACアドレス。

• IP Address

• [Channel]：Cisco Radioのチャネル番号または [Unavailable]（アクセスポイントが接続
されていない場合）。

• [CoverageHoles]：クライアントが接続を失うまで信号が弱まったクライアントのパー
センテージ。接続されていないアクセスポイントについては [使用不可
（Unavailable）]、monitor-onlyモードのアクセスポイントについては [MonitorOnly]
と表示されます。
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• [TXPower]：現在のCiscoRadioの送信電力レベル（1が高い）または [Unavailable]（ア
クセスポイントが接続されていない場合）。無線帯域を変更すると、マップ上の情報

もそれに応じて変更されます。

電力レベルはアクセスポイントのタイプによって異なります。Cisco Aironet 1000シ
リーズ Lightweightアクセスポイントは 1～ 5の値を受け入れます。Cisco Aironet
1230AGシリーズアクセスポイントは1～7の値を受け入れます。CiscoAironet 1240AG
シリーズアクセスポイントおよび Cisco Aironet 1100シリーズアクセスポイントは 1
～ 8の値を受け入れます。

• [Channel and Tx Power]：チャネルと送信電力レベルまたは [Unavailable]（アクセスポ
イントが接続されていない場合）。

• [Utilization]：関連付けられたクライアントデバイスで使用されている帯域幅のパーセ
ンテージ（受信、送信、およびチャネル使用率を含む）。アソシエーションを解除さ

れたアクセスポイントでは [Unavailable]、monitor-onlyモードのアクセスポイントで
は [MonitorOnly]が表示されます。

• [Tx Utilization]：指定されたインターフェイスの送信（Tx）使用率。

• [Rx Utilization]：指定されたインターフェイスの受信（Rx）使用率。

• [Ch Utilization]：指定されたアクセスポイントのチャネル使用率。

•関連付けられたClients]：関連付けられたクライアントの総数。

• [Dual-Band Radios]：Cisco Aironet 2800および 3800シリーズアクセスポイント上の
XORデュアルバンド無線を識別してマークします。

• [Health Score]：APの正常性スコア。

•問題数

•カバレッジの問題

• APダウンの問題

• [Heatmap Type]：ヒートマップは、変数から取得した値をマップに色として表した、無線
周波数（RF）ワイヤレスデータのグラフィック表示です。現在のヒートマップは、RSSI
予測モデル、アンテナの方向、および AP送信電力に基づいて計算されます。[Heatmap
Type]ドロップダウンリストからヒートマップのタイプを選択してください。ヒートマッ
プのタイプは次のとおりです。

• [None]

• [APRSSI]：特定の帯域のワイヤレス信号の強度を特定するカバレッジヒートマップ。

• [RSSI Cut off（dBm）]：スライダをドラッグして RSSIカットオフレベルを設定
します。RSSI Cutoffの範囲は -60 dBm～ -90 dBmです。

• [HeatmapOpacity（%）]：スライダを 0～ 100の範囲でドラッグして、ヒートマッ
プの不透明度を設定します。
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• [HeatmapColor Scheme]：緑色はヒートマップカバレッジ状態が良好であることを
示し、赤色はヒートマップカバレッジ状態が悪いことを示します。

• [Client Density]：関連付けられたクライアントの密度。

• [Map Opacity（%）]：スライダをドラッグしてマップの不透明度を設定します。

• [IDS]：ワイヤレスクライアントに提供されるモニターモードアクセスポイントカバ
レッジをフロアマップ上に示すヒートマップ。

• [Planned Heatmap]：計画ヒートマップは、フロアマップ上の計画アクセスポイントの
可能なカバレッジを示す架空のヒートマップです。

• [Coverage]：モニターモードアクセスポイントが除外されたヒートマップ（モニター
モードアクセスポイントがフロアプラン上にある場合にのみ利用可能）。

APの詳細はすぐにマップに反映されます。マップ上のAPアイコンにカーソルを合わせると、
APの詳細、RXネイバーの詳細、クライアントの詳細、およびスイッチの情報が表示されま
す。

センサーオプションの表示

[Sensors]ボタンをクリックすると、マップ上にセンサーが表示されます。[Sensors]パネルを展
開して、次の設定を行います。

• [Display Label]：ドロップダウンリストから、選択したアクセスポイントに関してフロア
マップに表示するテキストラベルを選択します。使用可能な表示ラベルは次のとおりで

す。

• [None]

• [Name]：センサー名。

• [Sensor MAC Address]：センサーのMACアドレス。

オーバーレイオブジェクトの表示オプション

オーバーレイオブジェクトをこれらの設定を構成するパネルに展開します。[On]/[Off]ボタン
を使用して、これらのオーバーレイオブジェクトをマップ上に表示します。

• [Coverage Areas]

• [Location Regions]

• [Obstacles]

• [Rails]

• [Markers]
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マッププロパティの設定

[Map Properties]パネルを展開して、以下を構成します。

• [AutoRefresh]：間隔のドロップダウンリストを使用して、データベースからマップデータ
を更新する頻度を設定できます。[Auto Refresh]ドロップダウンリストから、時間間隔
（[None]、[1 min]、[2 mins]、[5 mins]、または [15 mins]）を設定してください。

グローバルマッププロパティの設定

[Global Map Properties]パネルを展開し、次のように設定します。

• [Unit ofMeasure]：ドロップダウンリストを使用して、マップの寸法測定値を [Feet]または
[Meters]のいずれかに設定します。

ネットワーク階層マップでのデバイスデータのフィルタ処理

2Dワイヤレスマップの場合、アクセスポイントやセンサーにさまざまなフィルタを適用でき
ます。開始するには、マップツールバーの [Data]をクリックします。フィルタ条件に基づい
て、検索結果がテーブルに表示されます。

インベントリの管理
インベントリ機能は、ホストの IPアドレス、MACアドレス、およびそのデータベース内のデ
バイスに関するネットワークアタッチメントポイントなどの詳細を取得して保存します。

インベントリについて

インベントリ機能は、ホストの IPアドレス、MACアドレス、およびそのデータベース内のデ
バイスに関するネットワークアタッチメントポイントなどの詳細を取得して保存します。

また、インベントリ機能は、デバイスの制御性機能と連携して、デバイスに必要なネットワー

ク設定を構成することもできます（ネットワーク設定がデバイスにまだ存在しない場合）。

インベントリは、必要に応じて次のプロトコルを使用します。

•リンク層検出プロトコル（LLDP）

• IPデバイストラッキング（IPDT）またはスイッチ統合セキュリティ機能（SISF）（IPDT
または SISFをデバイス上で有効にする必要があります）。

• LLDPMedia Endpoint Discovery（このプロトコルは IPフォンや一部のサーバーの検出に使
用されます）。

•ネットワーク設定プロトコル（NETCONF）デバイスのリストについては、ディスカバリ
の前提条件（5ページ）を参照してください。

初期検出後、Cisco DNA Centerは定期的にデバイスをポーリングすることでインベントリを維
持します。デフォルトの間隔は 24時間ごとです。ただし、この間隔は、ネットワーク環境の
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必要性に応じて変更できます。詳細については、デバイスポーリング間隔の更新（54ページ）
を参照してください。また、デバイスの設定変更によってSNMPトラップがトリガーされ、次
にデバイスの再同期がトリガーされます。ポーリングはデバイス、リンク、ホスト、およびイ

ンターフェイスごとに実行されます。アクティブ状態が1日未満のデバイスのみが表示されま
す。これによって、古いデバイスデータが表示されないようにします。500個のデバイスの
ポーリングに約 20分かかります。

デバイスポーリング間隔の更新

[System] > [Settings] > [Network Resync Interval]の順に選択すると、グローバルレベルですべ
てのデバイスのポーリング間隔を更新できます。また、[Device Inventory]を選択すると、デバ
イスレベルで特定のデバイスのポーリング間隔を更新できます。[Network Resync Interval]を使
用してポーリング間隔を設定すると、その値が [Device Inventory]ポーリング間隔値よりも優先
されます。

デバイスにポーリングさせない場合は、ポーリングを無効にできます。

始める前に

インベントリにデバイスがあることを確認します。デバイスがない場合は、ディスカバリ機能

を使用して検出します。

ステップ 1 メニューアイコン（ ）をクリックして、[Provision] > [Inventory]の順に選択します。

ステップ 2 更新するデバイスを選択します。

ステップ 3 [Actions]ドロップダウンリストから [Inventory] > [Edit Device]の順に選択します。

ステップ 4 [Edit Device] slide-in paneで、[Resync Interval]をクリックします。

ステップ 5 再同期タイプを選択します。

•再同期タイプをグローバルとして設定するには、[System] > [Settings]の順に移動します。

•デバイス固有のポーリング時間は、グローバルなポーリング時間より優先されます。デバ
イス固有のポーリング時間を設定した後でグローバルなポーリング時間を変更した場合、

Cisco DNA Centerは引き続きデバイス固有のポーリング時間を使用します。

（注）

ステップ 6 [Resync Interval (in Mins)]フィールドで、連続するポーリングサイクル間の時間間隔（分単位）を入力しま
す。

ステップ 7 [更新（Update）]をクリックします。

インベントリに関する情報の表示

インベントリで検出されたデバイスに関する情報を表示およびフィルタリングできます。[Device]
テーブルに表示される情報をカスタマイズまたは変更できます。

アシュアランスを使用するための Cisco DNA Centerの設定
54

アシュアランスを使用するための Cisco DNA Centerの設定

デバイスポーリング間隔の更新



始める前に

インベントリにデバイスがあることを確認します。デバイスがない場合は、ディスカバリ機能

を使用して検出します。

ステップ 1 メニューアイコン（ ）をクリックして、[Provision] > [Inventory]の順に選択します。

[Inventory]ウィンドウには、検出プロセス中に収集されたデバイス情報が表示されます。

ステップ 2 （任意）インベントリビューを変更するには、右上隅にあるトグルボタン（ ）を使用します。

既定のビュー（リストレイアウト）を、トポロジやマップレイアウトなどの他のレイアウトに変更できま

す。

ステップ 3 （任意） [Devices]テーブルのフォーカスビューを変更するには、[Focus]ドロップダウンリストから、
[Default]、[Inventory]、または [Software Images]などのビューを選択します。

•表示される列は、選択したフォーカスビューに応じて変わります。

•選択したデバイスは、それぞれの新しいフォーカスビューで保持されます。

（注）

ステップ 4 （任意） [Devices]テーブルで特定のデバイスの詳細をフィルタ処理するには、次の操作を実行できます。

•デバイスファミリをフィルタ処理するには、[Inventory]ウィンドウの上部にある 1つまたは複数のデ
バイスファミリボタンを選択します。

たとえば、[Routers]をクリックすると、テーブル内にルーターのみを表示できます。

•デバイスの作業項目をフィルタ処理するには、左側のペインで、1つ以上の作業項目のチェックボッ
クスをオンにします。テーブルは、作業項目に対してすぐにフィルタ処理されます。

たとえば、[Unreachable]チェックボックスをオンにして、到達不能なデバイスのみをテーブルに表示
できます。

•特定のデバイスの詳細をフィルタ処理するには、[Filter devices]をクリックし、フィルタオプション
（[Quick Filters]、[Advanced Filters]、[Recent Filters]）から選択します。次に、[Apply]をクリックし
ます。

ステップ 5 （任意）右上隅にある[Take a tour]をクリックすると、[Inventory]ウィンドウの詳しい説明が見られます。

ステップ 6 （任意） [Devices]テーブルのすべてのデータをエクスポートするには、右上隅の[Export]をクリックしま
す。

ステップ 7 （任意） [Devices]テーブルをカスタマイズするには、右上隅にある設定アイコン（ ）をクリックし、

[Table Settings] slide-in paneで次のオプションから選択して、[Apply]をクリックします。

• [Table Appearance]：デフォルトまたはコンパクトなテーブルビューと、テーブルストライピングにし
たい場合に選択します。

• [Edit Table Columns]：カスタムビューを作成したい場合と、列の表示・非表示を選択します。列の選
択はセッション間では保持されない点に注意してください。

以下の表に、テーブルの特定の列に関係する重要な情報をまとめました。
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説明カラム

デバイスの名前。

デバイス名をクリックすると、そのデバイスの詳細情報が表示されます。

赤で表示されているデバイス名は、インベントリがデバイスをポーリングしてお

らず、30分を超える期間にわたってその情報を更新していないことを意味してい
ます。

（注）

Device Name

デバイスのサポートレベルが表示されます。

• [Supported]：Cisco DNACenterのすべてのアプリケーションに対してデバイスプロファイ
ルがテスト済みです。これらのデバイスのいずれかの Cisco DNA Center機能が動作しな
い場合は、サービスリクエストを開くことができます。

• [Limited]：レガシーデバイス用のデバイスプロファイルは、CiscoDNACenterの次の機能
のみを対象にベストエフォートベースでのみテストされています。

•検出

•トポロジ

•デバイスの到達可能性

•構成変更監査

•インベントリ

•ソフトウェアイメージ管理（ソフトウェアイメージは、cisco.comに記載のEOLデバ
イスでは利用できない場合があります。EOLデバイスには推奨されません。）

•テンプレートプロビジョニング（スイッチにのみ適用されます。）

詳細については、『Cisco DNA Center Compatibility Matrix』を参照してください。

• [Third Party]：デバイスプロファイルは、SNMP MIB-2値を入力できるサードパーティデ
バイスのCiscoDNACenterでテストされています。CiscoDNACenterはベストエフォート
ベースで、インベントリやトポロジなどの限られた基本的な自動化機能をサポートしま

す。

• [Unsupported]：CiscoDNACenterでテストおよび認定されていない他のすべてのシスコデ
バイスとサードパーティ製デバイス。これらのデバイスについて、CiscoDNACenterでさ
まざまな機能をベストエフォートとして試すことができます。ただし、CiscoDNACenter
の機能が期待どおりに動作しない場合、サービスリクエストやバグを申請することはで

きません。

Support Type
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説明カラム

以下は、さまざまなステータスのリストです。

• [Reachable]：Cisco DNACenterから SNMP、HTTP（S）、およびNETCONFポーリングを
使用してデバイスに到達できます。

• [Ping Reachable]：Cisco DNA Centerから ICMPポーリングを使用してデバイスに到達でき
ます。SNMP、HTTP（S）、および NETCONFポーリングでは到達できません。

• [Unreachable]：SNMP、HTTP（S）、NETCONF、ICMPのいずれのポーリングでもデバイ
スに到達できません。

Reachability

EoXスキャンのステータスが表示されます。

• [Success]：デバイスでの EoXアラートのスキャンに成功しました。

• [Not Scanned]：デバイスは EoXアラートについてスキャンされていません。

• [Scan Failed]：Cisco DNA Centerでデバイスでの EoXアラートのスキャンに失敗しまし
た。

• [Scanning]：Cisco DNA Centerでデバイスでの EoXアラートのスキャンを実行していま
す。

[EoX Status]の横にある [i]アイコンにカーソルを合わせ、[Click here to accept]をクリックし
て、EoXスキャンを開始します。

正常にスキャンされたデバイスについては、[EoXStatus]列にアラートの数が表示されます（あ
る場合）。

アラートの数をクリックすると、アラートの詳細が表示されます。

slide-in paneで、[Hardware]、[Software]、および [Module]タブをクリックして、ハードウェ
ア、ソフトウェア、およびモジュールの EoXアラートを表示します。

[EoX Status]

デバイスのステータスが示されます。

• [Managed]と緑色のチェックアイコン：デバイスに到達可能で、完全に管理されていま
す。

• [Managed]とオレンジ色のエラーアイコン：デバイスは管理されていますが、到達不能、
認証失敗、NETCONFポートがない、内部エラーなど、何らかのエラーがあります。エ
ラーメッセージにカーソルを合わせると、エラーおよび影響を受けるアプリケーション

に関する詳細が表示されます。

• [Unmanaged]：デバイスの接続の問題が原因でデバイスに到達できず、インベントリ情報
が収集されていません。

Manageability

シスコ製品の部品番号。Platform
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説明カラム

スキャンプロセス中に、検出された各デバイスに割り当てられているロール。デバイスロー

ルは、ネットワーク内での役目と配置に従って、デバイスを識別およびグループ分けするた

めに使用されます。Cisco DNA Centerでデバイスロールを特定できない場合、デバイスロー
ルは不明に設定されます。

デバイスロールを手動で変更すると、割り当ては静的のままになります。 Cisco
DNACenterは、後続のデバイスの再同期中に変更が検知されたとしても、デバイ
スロールは更新されません。

（注）

必要に応じて、このカラムのドロップダウンリストを使用して、割り当てられたデバイス

ロールを変更することができます。

Device Role

デバイスに割り当てられているサイト。デバイスがどのサイトにも割り当てられていない場

合は、[Assign]をクリックします。[Choose a site]をクリックし、階層からサイトを選択して
[Save]をクリックします。詳細については、ネットワーク階層の概要（32ページ）を参照し
てください。

Site

CiscoDNACenterがデバイスをスキャンし、デバイスに関する新しい情報でデータベースを更
新した最新の日付と時刻。

Last Updated

デバイスのポーリング間隔。再同期間隔は、[Inventory]ウィンドウから [Actions]> [EditDevice]>
[Resync Interval]の順に選択して設定します。再同期タイプを [Global]として設定するには、
メインメニューから [System] > [Settings]の順に選択します。詳細については、『Cisco DNA
Center Administrator Guide』を参照してください。

Resync Interval

デバイスで試行された最後のプロビジョニング操作のステータスが示されます。過去のプロ

ビジョニング操作のステータスを確認するには、[See Details]をクリックします。

• [Success]：デバイスでの最近の操作が成功しました。

• [Success]と警告アイコン：デバイスでの最近の操作は成功しましたが、過去のプロビジョ
ニング操作による障害があるため、注意が必要です。

• [Failed]：デバイスでの最近の操作が失敗しました。

• [Failed]と警告アイコン：デバイスでの最近の操作が失敗しました。過去のプロビジョニ
ング操作による障害があるため、注意が必要です。

• [Configuring]：デバイスは現在設定中です。

• [Pending]：システムは、進行中のプロビジョニング操作によってデバイスが影響を受ける
かどうかを判断しようとしています。

• [Not Provisioned]：デバイスは一度もプロビジョニングされていません。

• [Out of Sync]：デバイスのネットワーク設定またはネットワークプロファイルが、最後の
プロビジョニング操作の後に変更されました。

プロビジョニングス

テータス
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説明カラム

デバイスのクレデンシャルステータスが示されます。

• [Not Applied]：デバイスのクレデンシャルがデバイスに適用されていません。

• [Success]：デバイスのクレデンシャルがデバイスに正常に適用されました。

• [Failed]：デバイスのクレデンシャルがデバイスで失敗しました。

クレデンシャルの詳細を表示するには、[See Details]をクリックします。

[Credential Status] slide-in paneには、クレデンシャルの [Type]、[Name/Description]、[Status]、
および [Details]が表示されます。

ステータスが [Failed]のデバイスの場合、[Actions]列の省略記号アイコン（ ）の上にカー

ソルを置き、[Retry]または [Clear]を選択します。

• [Retry]：デバイスにクレデンシャルを適用します。

• [Clear]：デバイスのクレデンシャルをクリアします。

Credential Status

[Inventory]ウィンドウの APに接続されているスイッチとポートに関する詳細が表示されま
す。このウィンドウには、接続されたアクセススイッチが Cisco DNA Centerによって管理さ
れている場合でも、AP CDPネイバーに関する情報が表示されます。

AP CDP Neighbors

• [Edit CustomViews]：最初に、[Edit TableColumns]タブでカスタムビューを作成する必要があります。
それから、カスタムビューを編集できます。

• [Reset All Settings]：テーブル設定をデフォルト設定にリセットします。

ステップ 8 （任意） [Devices]テーブルからデバイスを管理するには、次のオプションがあります。

説明名前

[Add Device]をクリックして、ネットワークまたはコンピューティング
デバイスを追加するか、Merakiダッシュボードまたは Firepower
Management Center (FMC)をCisco DNA Centerと統合できます。

Add Device

[Tag]をクリックして、デバイスにタグを付けたり、タグを編集および
削除したり、ポートグループを作成したりできます。

タグ

[Actions]ドロップダウンリストを使用して、デバイス、ソフトウェアイ
メージ、テレメトリなどを管理できます。

各アクションオプションの詳細を表示するには、右隣の情報アイコン

（ ）をクリックします。

[Actions]ドロップダウンリスト

ステップ 9 （任意） [Devices]テーブルでは、次の操作を実行できます。

•昇順または降順で列をソートするには、列ヘッダーをクリックします。
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•デバイスの詳細を表示するには、デバイス名をクリックしてから、[View Device Details]をクリックし
ます。

•デバイスのコンプライアンスの詳細を表示するには、[Compliance]列で [Non-Compliant]または [Compliant]
をクリックします。

•サイトをデバイスに割り当てるには、[Site]列の下の [Assign]をクリックします。

•デバイスロールを変更するには、[DeviceRole]列の下にある編集アイコンをクリックし、[ACCESS]や
[CORE]などのオプションから選択します。

•イメージをゴールデンとしてマークするか、必要な更新を表示するには、[Software Image]列で [Mark
Golden]または [Needs Update]をクリックします。

•エントリの数を変更するには、ウィンドウの一番下までスクロールし、[Show Records]ドロップダウ
ンリストから、表示するエントリの数を選択します。

テーブルに25を超えるエントリがあり、別のフォーカスビューを選択した場合、新しい各ビューで同
じ数のエントリが表示されます。

各フォーカスビューには異なる列が表示され、テーブルビューをカスタマイズして、[Compliance]
、[Site]、[Device Role]、[Software Image]などの列を含めることができます。

（注）

ネットワークデバイスの削除

デバイスがまだサイトに追加されていない場合に限り、Cisco DNA Centerデータベースからデ
バイスを削除できます。

インベントリからワイヤレスセンサーを削除すると、センサーは工場出荷時のデフォルト状態

にリセットされるため、再接続すると現在の構成が採用されます。

始める前に

この手順を実行するには、管理者（ROLE_ADMIN）権限、およびすべてのデバイスへのアク
セス権（[RBAC Scope]を [ALL]に設定）が必要です。

ステップ 1 メニューアイコン（ ）をクリックして、[Provision]> [Network Devices]> [Inventory]の順に選択します。
[Inventory]ウィンドウには、ディスカバリプロセス中に収集されたデバイス情報が表示されます。

ステップ 2 削除するデバイスの横にあるチェックボックスをオンにします。

さらにチェックボックスをオンにして複数のデバイスを選択できますが、リストの上部にある

チェックボックスをクリックしてすべてのデバイスを選択できます。

（注）

ステップ 3 [Actions]ドロップダウンリストから [Inventory] > [Delete Device] > の順に選択します。

ステップ 4 [Warning]ウィンドウで、[Config Clean-Up]チェックボックスをオンにして、選択したデバイスからネット
ワーク設定およびテレメトリ設定を削除します。
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ステップ 5 [OK]をクリックして、アクションを確認します。

デバイスをサイトに追加する
デバイスをサイトに追加すると、Syslogサーバーおよび SNMPトラップサーバーとして Cisco
DNA Centerが設定されます。Syslogレベル 2が有効になり、グローバルテレメトリを設定で
きます。

ステップ 1 メニューアイコン（ ）をクリックして、[Provision] > [Network Devices] > [Inventory]の順に選択しま
す。

[Inventory]ウィンドウには、ディスカバリプロセス中に収集されたデバイス情報が表示されます。

ステップ 2 サイトに割り当てるデバイスのチェックボックスをオンにします。

ステップ 3 [Actions]メニューから、[Provision] > [Assign Device to Site]を選択します。

ステップ 4 [Assign Device To Site]スライドインペインで、デバイスの アイコンの横にあるリンクをクリックし

ます。

ステップ 5 [Choose a floor]スライドインペインで、デバイスに割り当てるフロアを選択します。

ステップ 6 [Save]をクリックします。

ステップ 7 （任意）複数のデバイスを選択して同じ場所に追加した場合は、最初のデバイスで [Apply to All]チェッ
クボックスをオンにすると、残りのデバイスに同じ場所を割り当てることができます。

ステップ 8 [Next]をクリックします。

ステップ 9 [Task Name]フィールドに、任意のタスク名を入力します。

ステップ 10 即座にデバイスをサイトに割り当てるには、[Now]オプションボタンをクリックし、[Assign]をクリック
します。

ステップ 11 将来の日付と時刻でデバイスのサイトへの割り当てをスケジュールするには、[Later]オプションボタン
をクリックして展開する日時を定義し、[Assign]をクリックします。

ステップ 12 CLI構成をプレビューするには、[GenerateConfiguration Preview]オプションボタンをクリックして、次の
手順を実行します。

• [Task Name]フィールドに任意のタスク名を入力し、[Preview]をクリックします。

後で、作成した構成のプレビューを使用して、選択したデバイスに展開できます。

• [Task Submitted]メッセージで、[Work Items]リンクをクリックします。

[TaskSubmitted]メッセージが表示されなかった場合は、メニューアイコンをクリックし、
[Activities] > [Work Items]の順に選択します。

（注）

• [Work Items]ウィンドウで、設定プレビュー要求を送信した CLIプレビュータスクをクリックしま
す。

• CLI設定の詳細を表示し、[Deploy]をクリックします。
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•即座にデバイスを展開するには、[Now]オプションボタンをクリックし、[Apply]をクリックします。

•将来の日付と時刻でデバイスの展開をスケジュールするには、[Later]オプションボタンをクリック
し、展開する日時を定義します。

•確認ウィンドウで [Yes]をクリックします。

CLIタスクは、[Work Items]ウィンドウで完了済みとしてマークされます。このタスクの
CLI設定は表示することはできますが、再度展開することはできません。

（注）

ステップ 13 サイトにデバイスを割り当てるときにデバイスの可制御性が有効になっていると、ワークフローが自動

的にトリガーされ、サイトからデバイスにデバイス設定がプッシュされます。

[Focus]ドロップダウンリストから [Provision]を選択し、[Provision Status]列の [See Details]をクリックし
ます。デバイスの可制御性を有効にしている場合、デバイスにプッシュされる設定が別のウィンドウに

表示されます。

Cisco DNA Center向けの Cisco ISEの設定について
ネットワークでのユーザー認証に Cisco ISEを使用している場合、Cisco DNA Centerを設定し
てCisco ISEを統合できます。統合することで、ユーザー名やオペレーティングシステムなど、
有線クライアントの詳細な情報を参照できます。

Cisco ISEの設定は NCP（ネットワーク制御プラットフォーム）内に一元化されているため、
単一の GUIで Cisco ISEを設定できます。Cisco ISEの設定ワークフローは次のとおりです。

1. メニューアイコン（ ）をクリックして、[System] > [Settings] > [External Services] >
[Authentication and Policy Servers]の順に選択して、Cisco ISEサーバーの詳細を入力しま
す。

2. Cisco ISEサーバーが正常に追加されると、NCPは NDP（ネットワークデータプラット
フォーム）との接続を確立し、pxGridノード、キーストア、およびトラストストアファイ
ルの詳細を送信します。

3. NDPは、NCPから受信した設定に基づき、pxGridセッションを確立します。

4. NCPがpxGridノードのフェールオーバーを自動的に検出すると、ペルソナが稼働し、NDP
に通信します。

5. ISE環境に変化があると、NDPは新しいpxGridアクティブノードと新しいpxGridセッショ
ンを開始します。

認証サーバとポリシーサーバの設定

Cisco DNA Centerは AAAサーバをユーザ認証に使用し、Cisco ISEをユーザ認証とアクセス制
御の両方に使用します。この手順を使って Cisco ISEを含む AAAサーバを設定します。
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始める前に

• Cisco ISEを使用してポリシーと AAA機能の両方を実行する場合、Cisco DNA Centerおよ
び Cisco ISEが統合されていることを確認します。

•他の製品（Cisco ISE以外）でAAA機能を使用している場合、以下に注意してください。

• AAAサーバーで Cisco DNA Centerを登録します。これには、AAAサーバーと Cisco
DNA Centerの共有秘密を定義することが含まれます。

• AAAサーバーで Cisco DNA Centerの属性名を定義します。

• CiscoDNACenterマルチホストクラスタの設定の場合は、AAAサーバーのマルチホス
トクラスタに、すべての個別のホスト IPアドレスと仮想 IPアドレスを定義します。

• Cisco ISEを設定する前に、以下の点を確認してください。

• Cisco ISEをネットワークに展開していること。サポートされている Cisco ISEバー
ジョンの詳細については、『Cisco DNA Center Compatibility Matrix』を参照してくだ
さい。Cisco ISEのインストールについては、Cisco Identity Services Engineインストー
ルおよびアップグレードガイド [英語]を参照してください。

•スタンドアロン ISE展開環境がある場合は、Cisco DNA Centerを Cisco ISEノードと
統合し、そのノード上でpxGridサービスと外部RESTfulサービス（ERS）を有効にす
る必要があります。

pxGrid 2.0ではCisco ISEの展開で最大 4つの pxGridノードを使用
できますが、Cisco DNA Center 2.2.1.x以前のリリースは 2つを超
える pxGridノードをサポートしていません。

（注）

•分散型 Cisco ISE展開がある場合：

• Cisco DNA Centerをプライマリポリシー管理ノード（PAN）と統合し、PAN上で
ERSを有効にする必要があります。

PAN経由で ERSを使用することを推奨します。ただし、バック
アップの場合は、PSN上で ERSを有効にできます。

（注）

•分散型展開環境内のいずれかの Cisco ISEノード上で pxGridサービスを有効化す
る必要があります。PAN上で pxGridサービスを有効化することを選択できます
が、必須ではありません。分散型展開環境にある任意の Cisco ISEノード上で
pxGridを有効にできます。

• TrustSecまたは SD-Accessのコンテンツと PACを処理するように Cisco ISEで設
定する PSNは、[Work Centers] > [Trustsec] > [Trustsec Servers] > [Trustsec AAA
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Servers]でも定義する必要があります。詳細については、『Cisco Identity Services
Engine Administrator Guide』を参照してください。

•ポート 443、5222、8910、9060で Cisco DNA Centerと Cisco ISEの通信を有効にする
必要があります。

• pxGridが有効化されている Cisco ISEホストには、Cisco ISE eth0インターフェイスの
IPアドレス上の Cisco DNA Centerから到達できる必要があります。

• Cisco ISEノードは、アプライアンス NIC経由でファブリックアンダーレイネット
ワークに到達できます。

• Cisco ISE管理ノード証明書のサブジェクト名またはサブジェクト代替名（SAN）のい
ずれかに Cisco ISEの IPアドレスまたは FQDNが含まれている必要があります。

• Cisco DNACenterシステム証明書の SANフィールドに、Cisco DNACenterアプライア
ンスの IPアドレスと FQDNの両方がリストされている必要があります。

Cisco ISE 2.4パッチ 13、2.6パッチ 7、および 2.7パッチ 3では、
pxGrid証明書に Cisco ISEのデフォルトの自己署名証明書を使用
している場合、証明書が Cisco ISEによって拒否されることがあ
ります。これは、その証明書の古いバージョンに、SSLサーバと
して指定されたNetscapeCert Type拡張があるためです。これは、
クライアント証明書が必要なため失敗します。

この問題は Cisco ISE 3.0以降では発生しません。詳細について
は、CiscoCloudAPICリリースノート [英語]を参照してください。

（注）

ステップ 1 メニューアイコン（ ）をクリックして、[System] > [Settings] > [External Services] > [Authentication and
Policy Servers]。

ステップ 2 [Add]ドロップダウンリストから、[AAA]または [ISE]を選択します。

ステップ 3 プライマリ AAAサーバーを設定するには、次の情報を入力します。

• [Server IP Address]：AAAサーバの IPアドレス。

• [Shared Secret]：デバイス認証のキー。共有秘密の長さは、最大 100文字です。

ステップ 4 Cisco ISEサーバーを設定するには、次の詳細情報を入力します。

• [Server IP Address]：ISEサーバーの IPアドレス。

• [Shared Secret]：デバイス認証のキー。

• [Username]：Cisco ISE CLIにログインするために使用するユーザー名。

このユーザーにはスーパーユーザーの管理権限が必要です。（注）
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• [Password]：Cisco ISE CLIユーザー名に対応するパスワード。

• [FQDN]：Cisco ISEサーバーの完全修飾ドメイン名（FQDN）。

• Cisco ISE（[Administration] > [Deployment] > [Deployment Nodes] > [List]）で定義され
ている FQDNをコピーして、このフィールドに直接貼り付けることをお勧めします。

•入力した FQDNは、Cisco ISE証明書で定義されている FQDN、共通名（CN）または
Subject Alternative Name（SAN）と一致する必要があります。

（注）

FQDNは、次の形式で、ホスト名およびドメイン名の 2つのパートで構成されています。

hostname.domainname.com

たとえば、Cisco ISEサーバーの FQDNは ise.cisco.comである可能性があります。

• [Virtual IP Address（es）]：Cisco ISEポリシーサービスノード（PSN）が背後に配置されているロード
バランサの仮想 IPアドレス。異なるロードバランサの背後に複数の PSNファームがある場合は、最
大 6つの仮想 IPアドレスを入力できます。

ステップ 5 [Advanced Settings]をクリックして、設定を構成します。

• [Connect to pxGrid]：pxGrid接続を有効にするには、このチェックボックスをオンにします。

Cisco DNA Centerシステム証明書を pxGridクライアント証明書として使用する場合（pxGridクライア
ントとして Cisco DNA Centerシステムを認証するために Cisco ISEに送信）、[Use Cisco DNA Center
Certificate for pxGrid]チェックボックスをオンにします。動作環境で使用されるすべての証明書を同じ
CAで生成する必要がある場合は、このオプションを使用できます。このオプションを無効にすると、
Cisco DNA Centerは、システムが使用する pxGridクライアント証明書を生成するための要求を Cisco
ISEに送信します。

このオプションを有効にする場合は、次のことを確認してください。

• Cisco DNA Center証明書が、Cisco ISEで使用中の CAと同じ認証局（CA）によって生成されてい
ること（そうでない場合、pxGrid認証は失敗します）。

• [Certificate Extended Key Use（EKU）]フィールドに「クライアント認証」が含まれていること。

• [Protocol]：[TACACS]と [RADIUS]（デフォルト）。両方のプロトコルを選択できます。

ここで Cisco ISEサーバーの TACASを有効にしない場合は、ネットワークデバイス認証用
に AAAサーバーを設定するときに、[Design] > [Network Settings] > [Network]で Cisco ISE
サーバーを TACASサーバーとして設定できません。

注目

• [Authentication Port]：AAAサーバーへの認証メッセージのリレーに使用されるポート。デフォルトの
UDPポートは 1812です。

• [AccountingPort]：AAAサーバーへの重要なイベントのリレーに使用されるポート。デフォルトのUDP
ポートは 1813です。

• [Port]：デフォルトの TACACSポートは 49です。
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• [Retries]：接続の試行が中止される前に、Cisco DNA Centerが AAAサーバへの接続を試みた回数。デ
フォルトの試行回数は 3回です。

• [Timeout]：接続の試行が中止される前に、デバイスが AAAサーバーの応答を待機するタイムアウト
期間。デフォルトのタイムアウトは 4秒です。

必要な情報を入力すると、Cisco ISEは 2つのフェーズを経て Cisco DNA Centerと統合されま
す。統合が完了するまでには数分かかります。フェーズごとの統合ステータスは、[Authentication
and Policy Servers]ウィンドウと [System 360]ウィンドウに表示されます。

Cisco ISEサーバー登録フェーズ：

• [Authentication and Policy Servers]ウィンドウ：「進行中」

• [System 360]ウィンドウ：「プライマリ使用可能」

pxGridサブスクリプション登録フェーズ：

• [Authentication and Policy Servers]ウィンドウ：「アクティブ」

• [System 360]ウィンドウ：「プライマリ使用可能」および「pxGrid使用可能」

設定された Cisco ISEサーバーのステータスがパスワードの変更により [FAILED]と表示されて
いる場合は、[Retry]をクリックし、パスワードを更新して Cisco ISE接続を再同期します。

（注）

ステップ 6 [Add]をクリックします。

ステップ 7 セカンダリサーバーを追加するには、前述の手順を繰り返します。

テレメトリを使用したSyslog、SNMPトラップ、NetFlow
コレクタサーバー、および有線クライアントデータ収集

の設定
Cisco DNA Centerでは、デバイスを特定のサイトに割り当てる際のグローバルネットワーク設
定を構成できます。テレメトリを使用すると、ネットワークデバイスがポーリングされ、SNMP
サーバー、syslogサーバー、NetFlowコレクタ、または有線クライアントの設定に従ってテレ
メトリデータが収集されます。

始める前に

サイトを作成し、サイトにデバイスを割り当てます。『ネットワーク階層のサイトの作成（35
ページ）』を参照してください。

ステップ 1 [Design] > [Network Settings] > [Telemetry]の順に選択します。メニューアイコン（ ）をクリックして、
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ステップ 2 [SNMP Traps]エリアで、次のいずれかを実行します。

• [Use Cisco DNA Center as SNMP trap server]チェックボックスをオンにします。
• [Add an external SNMP trap server]チェックボックスをオンにし、外部 SNMPトラップサーバーの IPア
ドレスを入力します。選択したサーバーによってネットワークデバイスから SNMPトラップとメッ
セージが収集されます。

ステップ 3 [Syslogs]エリアで、次のいずれかを実行します。

• [Use Cisco DNA Center as syslog server]チェックボックスをオンにします。
• [Add an external syslog server]チェックボックスをオンにし、外部 syslogサーバーの IPアドレスを入力
します。

ステップ 4 [NetFlow]エリアで、次のいずれかを実行します。

• [Use Cisco DNA Center as NetFlow collector server]オプションボタンをクリックします。デバイスイン
ターフェイスの NetFlowの構成は、デバイスでアプリケーションテレメトリを有効にした場合にのみ
完了します。NetFlowの宛先サーバーをデバイスに設定するには、サイトレベルで NetFlowコレクタ
を選択します。

• [Add Cisco Telemetry Broker (CTB)]オプションボタンをクリックし、Cisco Telemetry Brokerの IPアド
レスとポート番号を追加します。Cisco Telemetry Brokerはデバイスから NetFlowレコードを収集し、
その情報を宛先に送信します。

NetFlowレコードを受信するには、Cisco Telemetry Brokerで Cisco DNA Centerが宛先とし
て設定されている必要があります。CiscoDNACenterが宛先として設定されていない場合、
アプリケーションエクスペリエンスは機能しません。

（注）

ステップ 5 [Wired Client Data Collection]エリアで、[Enable Cisco DNA Center IPDT on all devices]オプションボタンをク
リックして、サイトのアクセスデバイスで IPデバイストラッキング（IPDT）をオンにします。

サイトの IPDTを有効にしない場合は、[Disable]オプションボタン（デフォルト）をクリックします。

CLI構成をプレビューするには、IPDTを有効にする必要があります。デバイスをプロビジョニ
ングする場合、デバイスに展開する前に CLI構成をプレビューできます。

（注）

ステップ 6 [Wireless Controller, Access Point and Wireless Clients Health]エリアで、[Enable Wireless Telemetry]チェック
ボックスをオンにして、ネットワーク内のワイヤレスコントローラ、AP、およびワイヤレスクライアント
の状態をモニターします。

ステップ 7 [Save]をクリックします。

Cisco AI Network Analyticsデータ収集の設定
Cisco AI Network Analyticsが、ネットワークデバイスおよびサイト階層から Cisco DNA Center
にネットワークイベントデータをエクスポートできるようにするには、次の手順を実行しま

す。
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始める前に

• Cisco DNA Center用の Cisco DNA Advantageソフトウェアライセンスを保有していること
を確認してください。AIネットワーク分析アプリケーションは、CiscoDNAAdvantageソ
フトウェアライセンスに含まれています。

• AIネットワーク分析アプリケーションがダウンロードおよびインストールされているこ
とを確認します。Cisco Digital Network Architecture Center管理者ガイドの「パッケージと
更新のダウンロードとインストール」のトピックを参照してください。

•ネットワークまたは HTTPプロキシが、次のクラウドホストへのアウトバウンド HTTPS
（TCP 443）アクセスを許可するように設定されていることを確認します。

• [api.use1.prd.kairos.ciscolabs.com]（米国東部地域）

• [api.euc1.prd.kairos.ciscolabs.com]（EU中央地域）

ステップ 1 メニューアイコン（ ）をクリックして、[System] > [Settings]の順に選択します。

ステップ 2 [External Services]までスクロールし、[Cisco AI Analytics]を選択します。
[AIネットワーク分析（SIP MWI notification mechanism）]ウィンドウが表示されます。

ステップ 3 次のいずれかを実行します。

•アプライアンスに以前のバージョンの Cisco AI Network Analyticsがインストールされている場合は、
次の手順を実行します。

1. [Recover from a config file]をクリックします。

[Restore AIネットワーク分析]ウィンドウが表示されます。

2. 表示されたエリアにコンフィギュレーションファイルをドラッグアンドドロップするか、ファイ
ルシステムからファイルを選択します。

3. [Restore]をクリックします。

CiscoAI NetworkAnalyticsの復元には数分かかる場合があり、その後、[Success]ダイアログボック
スが表示されます。
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• Cisco AI Network Analyticsを初めて設定する場合は、次の手順を実行します。

1. [Configure]をクリックします。

2. [Where should we securely store your data?]領域で、データを保存する場所を選択します。[Europe
(Germany)]または [US East (North Virginia)]を選択できます。

[Testing cloud connectivity...]タブで示されているように、システムはクラウド接続のテストを開始
します。クラウド接続のテストが完了すると、[Testing cloud connectivity...]タブが [Cloud connection
verified]に変わります。

3. [Next]をクリックします。

[terms and conditions]ウィンドウが表示されます。

4. [Accept CiscoUniversal CloudAgreement]チェックボックスをオンにして契約条件に同意してから、
[Enable]をクリックします。

CiscoAI NetworkAnalyticsが有効になるまでに数分かかる場合があり、その後、[Success]ダイアロ
グボックスが表示されます。
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ステップ 4 [Success]ダイアログボックスで [Okay]をクリックします。
AIネットワーク分析ウィンドウが表示され、[Enable AI Network Analytics]トグルボタン が表示されま

す。

ステップ 5 （推奨）AIネットワーク分析ウィンドウで、[Download Configuration]ファイルをクリックします。

Cisco AI Network Analyticsデータ収集の無効化
Cisco AI Network Analyticsのデータ収集を無効にするには、次のようにAI Network Analytics機
能を無効にする必要があります。

ステップ 1 メニューアイコン（ ）をクリックして、[System] > [Settings]の順に選択します。

ステップ 2 [External Services]までスクロールし、[Cisco AI Analytics]を選択します。

各機能のチェックマーク（ ）は、その機能が有効になっていることを示します。チェックボックスが

オフの場合（ ）、機能は無効になっています。

ステップ 3 [AI Network Analytics]領域で、[Enable AI Network Analytics]トグルボタンをクリックしてオフにします

（ ）。

ステップ 4 [Update]をクリックします。

ステップ 5 CiscoAINetworkAnalyticsクラウドからネットワークデータを削除するには、Cisco Technical ResponseCenter
（TAC）に連絡してサポートリクエストをオープンします。

ステップ 6 （オプション）以前の設定が間違って配置されている場合は、[Download configuration file]をクリックしま
す。

機械推論ナレッジベースの更新
機械推論ナレッジパックは、機械推論エンジン（MRE）がセキュリティの問題を特定し、根本
原因の自動分析を改善するために使用する、段階的なワークフローです。これらのナレッジ

パックは、より多くの情報を受信しながら継続的に更新されます。機械推論ナレッジベース

は、これらのナレッジパック（ワークフロー）のリポジトリです。最新のナレッジパックにア

クセスするために、機械推論ナレッジベースを毎日自動更新するようにCiscoDNACenterを設
定することもできれば、手動更新を実行することもできます。

ステップ 1 メニューアイコン（ ）をクリックして、[System] > [Settings]の順に選択します。

ステップ 2 [External Services]まで下にスクロールし、[Machine Reasoning Knowledge Base]を選択します。
[Machine Reasoning Knowledge Base]ウィンドウには、次の情報が表示されます。

• [INSTALLED]：インストールされている機械推論ナレッジベースパッケージのバージョンとインストー
ル日が表示されます。
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機械推論ナレッジベースの新しいアップデートがある場合は、[Machine Reasoning Knowledge Base]ウィン
ドウに [AVAILABLE UPDATE]領域が表示され、アップデートの [Version]と [Details]が示されます。

• [AUTO UPDATE]：機械推論ナレッジベースが Cisco DNA Centerで自動的に毎日更新されます。

• [CISCO CX CLOUD SERVICE FOR NETWORK BUG IDENTIFIER AND SECURITY ADVISORY]：自動
構成を実行できる CX Cloudと Cisco DNA Centerを統合します。この統合により、Cisco DNA Centerの
セキュリティアドバイザリツールからデバイスの強化された脆弱性検出が直接提供されます。

ステップ 3 （推奨）[AUTO UPDATE]チェックボックスをオンにして、機械推論ナレッジベースを自動的に更新しま
す。

[Next Attempt]領域に、次回の更新の日付と時刻が表示されます。

自動更新は、Cisco DNA Centerがクラウドの機械推論エンジンに正常に接続されている場合にのみ実行で
きます。

ステップ 4 機械推論ナレッジベースを Cisco DNA Centerで手動で更新するには、次のいずれかを実行します。

• [AVAILABLE UPDATES]の下にある [Update]をクリックします。[Success]ポップアップウィンドウが
表示され、更新のステータスが表示されます。

•機械推論ナレッジベースをローカルマシンに手動でダウンロードして Cisco DNA Centerにインポート
します。次の手順を実行します。

1. [Download]をクリックします。

[Opening mre_workflow_signed]ダイアログボックスが表示されます。

2. ダウンロードしたファイルを開くか、ローカルマシンの目的の場所に保存して、[OK]をクリック
します。

3. [Import]をクリックして、ダウンロードした機械推論ナレッジベースをローカルマシンから Cisco
DNA Centerにインポートします。

ステップ 5 [CISCOCXCLOUDSERVICE FORNETWORKBUG IDENTIFIERANDSECURITYADVISORY]チェックボッ
クスをオンにして、ネットワークバグ IDおよびセキュリティアドバイザリとの Cisco CX Cloudの連携を
有効にします。

ステップ 6 [Security Advisories Settings]エリアで、[RECURRING SCAN]トグルボタンをクリックして、毎週の定期的
なスキャンを有効または無効にします。

ステップ 7 [CISCO CX CLOUD]トグルボタンをクリックして、Cisco CX Cloudを有効または無効にします。

ローカリゼーションの有効化
CiscoDNACenterのGUI画面は、英語（デフォルト）、中国語、日本語または韓国語で表示で
きます。

デフォルトの言語を変更するには、次のタスクを実行します。
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ステップ 1 ブラウザで、サポートされている言語（中国語、日本語、または韓国語）のいずれかにロケールを変更し
ます。

• Google Chromeから、次の手順を実行します。

1. 右上隅にある アイコンをクリックし、[Settings]を選択します。

2. 下にスクロールして [Advanced]をクリックします。

3. [Languages] > [Language]ドロップダウンリストから、[Add languages]を選択します。

[Add languages]ポップアップウィンドウが表示されます。

4. [Chinese]、[Japanese]、または [Korean]を選択して、[Add]をクリックします。

• Mozilla Firefoxから、次の手順を実行します。

1. 右上隅にある アイコンをクリックし、[Options]を選択します。

2. [Language and Appearance] > [Language]エリアから、[Search for more languages]を選択します。

[Firefox Language Settings]ポップアップウィンドウが表示されます。

3. [Select a language to add]ドロップダウンリストから、[Chinese]、[Japanese]、または [Korean]を選択
します。

4. [OK]をクリックします。

ステップ 2 Cisco DNA Centerにログインします。

GUI画面は、選択した言語で表示されます。
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図 2 :ローカライズされたログイン画面の例
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翻訳について
このドキュメントは、米国シスコ発行ドキュメントの参考和訳です。リンク情報につきましては
、日本語版掲載時点で、英語版にアップデートがあり、リンク先のページが移動/変更されている
場合がありますことをご了承ください。あくまでも参考和訳となりますので、正式な内容につい
ては米国サイトのドキュメントを参照ください。


